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Chapter 1.
E-Commerce Overview

Introduction

Welcome!  You have just embarked on a fantastic journey.  You now have in your possession
the one tool that enables you to set up a fully functioning Internet WebStore.  Before you begin,
you will want to get an overview of the functionality that makes your E-commerce Web site
work.  That is what this chapter is going to cover.  You probably also want to get an idea of
what your customers will see.  This chapter looks at that, too.  You should know, however, that
this E-Commerce User Guide assumes you already are familiar with the WebShop User Guide.
So, if you aren’t, you might want to spend some time learning about the basic WebShop
functionality before you sit down to read this manual.

Topics covered in this chapter include:

• What’s an E-Commerce Web Site All About?

• Two Parts to an E-commerce Web Site

• E-Commerce Functionality

• What Your Customers Will See

• Assistance in Using WebShop

• Technical Support

• User Guide Conventions

What’s An E-Commerce Web Site All About?

Creating an E-Commerce site is more involved than creating a simple Web site.  A number of
site design elements must work together to make possible a successful E-commerce transaction.
The following will help you understand how it all works.

To create an E-Commerce site you must start with one of the E-Commerce templates provided
with WebShop.  When you create an E-Commerce site, it is in fact a Web site.  Just like any
Web site—it has text display features and hyperlinks.  However, it also has specifically de-
signed E-commerce functionality that makes it different from a normal Web site.
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Just like any Web site, you must place your E-commerce site on a Web server that provides
Internet access.  However, to operate an E-commerce site, your Web-hosting service must
provide Windows NT-server support and must specifically configure your site to enable its E-
commerce functionality.  You should contract for this hosting service and obtain a valid URL
address for your site prior to beginning development.  You can obtain such NT-based hosting
service directly from Boomerang Software, or you can use another Internet provider or Web
hosting service that supports a Windows NT-server.

Note: For more information, see the chapter titled “Working with Your ISP and Uploading
Your Site.”

When creating an E-commerce site, you, most likely, are serving not only the Web designer, but
also the merchant.  As merchant, you deploy or use your site to sell items on the Internet.
Visitors to your site are “customers.” Of course, some come to view and not buy, but, hopefully,
many others do.  To have your site pre-approved to accept credit card payments, you must be a
“credit card authorized merchant.” This simply means that you fill out certain forms and
provide some information about you and your new or existing business.  If you like, you can
apply online.  WebShop comes with an online Merchant Registration feature.  If approved, a
merchant (or store) ID is assigned to you.  This ID makes you an authorized merchant and
enables your Web site to accept credit card payments from your customers.  WebShop provides
this important link to state-of-the-art, real-time, instant verification and transaction processing.

Real-time instant verification means that when a customer enters his or her credit card informa-
tion, your E-commerce site connects to the appropriate banking institutions and verifies the
customer’s credit card account and amount being charged.  Once this verification processing is
complete, it notifies the customer and either accepts or declines the purchase transaction.

Transactions processing means that the funds needed for a purchase (after verification and
acceptance is done) are automatically deposited into your bank account.  This saves you time
and maximizes your availability of funds.

In addition to the above features, WebShop also provides extensive database support for your E-
commerce site.  Your E-commerce database is critical to the success of your E-commerce site
and has a several parts.

••••• A Products Database .  This is where you import or build the your database of products for
sale.

••••• An Orders Database .  This is where WebShop stores all the verified and accepted orders
received for your shop.

When customers visit your WebStore to browse through your products for sale, they must use
WebShop’s Shopping Cart feature if they want to begin placing an order.  This feature enables
customers to accumulate several product selections as they browse and provides summary totals
and other data regarding the anticipated actual purchase.  Only after the customer has collected
all of the products he/she wants, does the order process begin.
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Since your E-commerce database is so important, WebShop comes with a powerful Wizard that
helps you gather the necessary data.  This Wizard automatically begins once you open any of
the pre-designed E-commerce templates.

Now that you have a broad overview of some of the built-in features that come with WebShop
and make your E-commerce distinctively different from a standard Web site, let’s look at how
you might want to build your Web site.

Two Parts to an E-Commerce Web Site

Any E-commerce Web site generated by WebShop can have two parts:

• The front-end Web site that does not  make use of E-commerce functionality.

• The back-end WebStore that does  make use of E-commerce functionality.

The front-end part of an E-commerce Web site can include anything that you want: company
history, a personnel directory, an organization chart, public relations announcements—suffice it
to say “virtually anything.” Now, no one says you must have a Web site front end, but many
people find they do want one.  Generating these additional materials is very easy with Web-
Shop.  So, go ahead—you can be as creative as you want.

The back-end WebStore, however, needs to follow certain rules.  Because WebShop uses pre-
designed templates to implement E-commerce functionality, many of the E-commerce Web
pages should not be altered.  The predesigned functionality embedded in these Web pages is
much more difficult to customize than the relatively “free-form” front-end.  And unless you
want to spend a lot of time doing a significant amount of additional work, we recommend that
you keep your changes to these back-end Web pages to a minimum.

E-Commerce Functionality

What is E-commerce functionality? Well, simply put, it is everything that enables your custom-
ers to transact business.  That includes: displaying products, enabling customers to make
selections, calculating invoice amounts, recording shipping instructions, and confirming orders.
That is very complicated functionality, if you had to build it yourself.  To make it all happen,
WebShop has put together a tightly constructed set of dynamic pages that display and record
information—dynamically.  In essence, these Web pages contain short “display programs” that
interact with your customer to dynamically display and record information as they interact with
your E-commerce Web site.  Where normal pages provide interaction using hypertext links,
dynamic pages do much more.  They not only make use of hypertext links, they also access data
from a database and record data into a database.  Standard Web pages do not make use of this
kind of a dynamic read and write capability.  That’s what makes creating an E-commerce Web
site both complex and exciting!
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What Your Customers Will See

As an E-commerce merchant, you are most likely concerned with what your Web customers
will see.  A finished WebStore has a number of visible elements:

• A Web site StoreFront (which can be used as your Home Page)

• A page for product display and selection

• A shopping cart summary of items selected

• A customer data form

• A shipping and payment data form, and

• A secured transaction order form with order confirmation.

Each of these visible elements uses E-commerce functionality.  This is where it all happens!

Assistance in Using WebShop

WebShop includes four forms of documentation for your convenience:

••••• User Guide .  This printed document provides an overview of the operation of the Web-
Shop application.

••••• Quick Start Guide .  This printed document provides a step by step overview of significant
WebShop features.

••••• E-Commerce User Guide .  This printed document provides an overview of the E-Com-
merce features of the WebShop application.

••••• Windows Help System .  For quick reference on a particular operation or feature in
WebShop, you may use the Help system.  You may access the Help files by selecting the
Help > Contents  menu options or by pressing F1.  The Help file includes a subject index, a
word index (Windows 95), and extensive cross-reference links to related subjects.  The
Help file is ideal for the ability to find specific detailed information using the search
feature, or by using the many Help buttons located through the WebShop application.

Technical Support

Before you call Technical Support, please check the Readme  file to see if it can answer your
question.  If you cannot solve your problem, contact Boomerang tech support at the following
phone number, fax number, or mail address:

Tech Support (voice): 617.484.4664
Tech Support (email): techsupport@boomerangsoftware.com
Tech Support (fax): 617.489.1486
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Tech Support (mail): Boomerang Software, Inc.
ATTN: Tech Support
90 Concord Ave.
Belmont, MA 02478

It is more effective if you follow these guidelines when contacting tech support by voice:

• Record the exact sequence of events that created the problem.  Make sure that you can
reproduce the problem by following the same series of steps.

• Know the version number for WebShop.  To get the exact version number, choose the
Help > About  menu option in WebShop.

• Know the type of computer and the version of Windows that you are using.

• Record the text of any error messages that may appear with regard to the problem.

• Be at your computer with the computer turned on when you call.

User Guide Conventions

There are several document conventions you need to know:

• Text that you are required to type are indicated in a sans-serif font with quotation marks.
For example: “CD\TEMP”  Ignore any punctuation unless it is included within the quota-
tion marks.

• Keystrokes, or individual keys that you are asked to press are indicated in a bold, all capital
text, such as: ALT , F1, TAB , ENTER.

• When you are instructed to select more than one menu option in sequence, the options are
separated by a greater-than sign (>).  The instruction “Select Frames > Advanced >
Rename” asks you to complete these steps in sequence: 1.  select the Frames  menu; 2.
select the Advanced  option in the Frames menu; and 3.  select the Rename  option in the
Advanced menu.

• When you are instructed to “select,” “click,” or “double-click” with the mouse, use the left
mouse button.  In some cases, you will be instructed to “right-click.” If you have reversed
the configuration of the mouse buttons in Windows, you should reverse the button instruc-
tions in this User Guide.

• When you are instructed to “select” or “highlight” an item or icon, click on it once.  In
some cases, it may be surrounded by blue or the prevailing “active” Windows system color.

Note: Program operations in WebShop can be launched by using one of these methods: 1.
A sequential menu option selection, as described in the third bullet above; 2. Clicking on a
program icon or toolbar button; 3. Selecting an item or object, right-clicking and then
selecting a program option from the pop-up menu; and 4.  Pressing a single or combination
shortcut key.
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Introduction

As an E-commerce merchant, you are most likely concerned with what your Internet customers
will see and do once they get to your site.  A completed “WebStore,” which is what your Web
site has become, has a number of visible elements:

• A StoreFront page

• A Shopping page for product display and selection

• A “shopping cart” summary of items selected

• A customer data form

• A shipping and payment data form, and

• A secured transaction order form with an order confirmation.

Each of these visible elements uses E-commerce functionality.  This is where it all happens!
The purpose of this chapter is to provide you with a storybook overview of what your customers
will see and do when they go shopping.

Topics covered in this chapter include:

• Browsing for Products vs. Placing an Order

• Entering the WebStore

• Accessing Company Information

• Browsing the Merchandise for Sale

• Selecting Items to Buy and Browsing for More

• Specifying Quantities from the Shopping Cart

• Getting Customer Information

• Specifying Shipping Details and Payment Method

• Submitting the Order for Transaction Processing

• Reviewing the Order Prior to Payment

• Receiving Online Confirmation

• Email Confirmations
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Browsing for Products vs. Placing an Order

When your customers enter your WebStore they are most likely going to browse through your
products.  Some will decide to buy, others will not.  To demonstrate the functionality of your E-
commerce Web site, this chapter looks at the various steps that a customer who wants to buy
would have to take to purchase a product.  Customers who browse may access everything you
have created without completing the order entry process.

The browsing process includes:

• Entering the WebStore

• Accessing company information

• Browsing the merchandise for sale

• Selecting items to buy and specifying quantities

Currently there is no requirement that browsing shoppers register as a customer.  Customers can
remain anonymous up until the time they begin the order process.  We have tried to encourage
shoppers to register as customers even if they do not buy anything.  We have put a Register
Now  hyperlink on the Company Information default that comes up whenever customers first
start to browse your merchandise for sale.

The order entry process includes:

• Registering as a customer

• Specifying shipping details and payment method

• Reviewing the order prior to payment

• Submitting the order for transaction processing

• Receiving online confirmation

• Receiving email confirmation

Order entry includes financial processing and transaction processing.  Financial processing is
the real-time instant verification of a customer’s credit card account and includes depositing
funds into the merchant account.  Transaction processing is everything else—from submitting
the order for processing on.  The final step in the order entry process is when online and email
confirmations are sent.  Customers can stop the order entry process at any time prior to this
simply by leaving the Web site or failing to complete the order entry process.

Note: What you are going to see in this chapter is what your customers will see.  That
means that the graphics contained in the chapter are what your customer would see using
a browser.   These are online displays of what your E-commerce Web site will look like to
your customer if a standard E-commerce template  without substantial modification is
used.



E-Commerce User Guide 2–3

Chapter 2.  What Your Shoppers See and Do

Entering the WebStore

When a customer first enters the WebStore, the first Web page that they will see is the Store-
Front.

Features that your customer will see:
• An inviting graphic (but not too large, nor too slow loading)

• A text link to your Company Information page that provides contact information

• A text link to your WebStore Shopping page that displays your merchandise for sale

• A “hidden” graphic link to your Administration page.  This link is for your use only.  While
customers may be able to see it, they will be unable to access the administration page
without passing a security check.  You are not required to retain this graphic hyperlink.

• A text message encouraging your customers to configure their browsers for cookies.
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Note: It is important that your customers configure their browsers to accept cookies.
Cookies are user IDs automatically generated from the server side (that is, from your Web
site) and then stored on your customer’s PC.  When a customer first enters your WebStore,
this user ID is necessary to uniquely identify them.  Without this identification, your Web-
Store is unable to let a customer browse through your merchandise.  Customers who are
not configured for cookies receive a warning message whenever they try to go shopping.
However, by default, both Microsoft Explorer and Netscape Navigator accept cookies.  So,
for most of your customers, this will not be a problem.

Actions that your customer can take:
• Begin shopping by clicking on the Click here to go Shopping!   link.

• Go to the Company Information page by clicking on the Company Information!   link.

Accessing Company Information

Some of your customers will want to learn more about you.  To assist them, the StoreFront has a
text or graphic link that takes them to the Company Information page.
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Features that your customer will see:
• Your company name

• Your company address

• Your phone number, email address, and fax number

• A Home Page navigation bar

• Your WebShop’s current Customer Identification—if customer is anonymous, then the
visitor ID is displayed; if the customer has already registered, then the first name, last
name, and country is displayed

• Links to the Shopping Cart and to Customer Registration

Actions that your customer can take:
• Begin registration by clicking on the Register Now  link.

• View the contents of their shopping cart by clicking on the View  Shopping Cart  link.

• Return to the StoreFront by clicking on the Home  navigation bar.

Note: When customers first enter your WebStore, by default their shopping cart is empty.  If
they are returning to complete a transaction, your WebStore is able to identify them and
display the contents of their shopping cart from their earlier visit.  Your WebStore empties a
customer’s Shopping Cart only when the order process is complete.

Browsing the Merchandise for Sale

When customers begin to browse the merchandise for sale they have linked into your
WebStore’s shopping page.  The shopping page is a dynamic page (that is, a page that interac-
tively displays information based on customer selections).  This shopping page allows your
customers to decide those products they want to see.

There are many entry points to your WebStore’s Shopping Page.  The most common is from the
StoreFront.  Other ways that customers can access your WebStore’s Shopping Page include:

• From the Shopping Cart,

• From the Customer Information page where they register as a customer, and

• During the order entry process where they specify their shipping details and payment
method.

Since your Shopping page contains a significant amount of E-commerce functionality, you
should not change the display and operation of this page.
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Features that your customer will see when a product is displayed:
• Frame page design with two frames—the left side frame contains; product categories, a

product search tool and a customer information navigation bar; the right side frame
contains the default Company Information page.  When first accessed the customer has not
selected a product category to display, so the Company Information page is displayed.

Actions your customer can take when a product is displayed:
On the left side, customers can

• Select a product category to display by clicking on one of the categories listed.

• Perform a product search (see the topic “Using the Product Search Tool” later in this
chapter).

• Go to the company information page, by clicking on the Company Information
 navigation bar.

On the right side, customers can

• Begin registration by clicking on the Register Now  link.

• Perform a product search using the Product Search Tool.
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•  View the contents of their shopping cart by clicking on the View  Shopping Cart  link.

•  Return to the StoreFront by clicking on the Home  navigation bar.

Once a product category is selected, the products in the selected category are displayed on the
right side frame.  The left side frame remains unchanged.

Features that your customer will see on the right:
• The name of the product category displays at the top

• The products included in this category displayed with each product display listing the
following details: Product Image, Product Name, Product Description, Product Code, Unit
Price.  Each product display contains a separate Buy  button.

Actions that your customer can take:
• Select a product for purchase by clicking on the Buy  button.

• To continue browsing, by clicking on another product category.
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4. When you are done, click Search the Shop .  The search results are displayed on the right.
If no products are found, the message “No products match search criteria”  is displayed.

To search for products based on price

1. Select the type of search by clicking on the Price Between  check box.

2. Specify a price range, by entering a low and high value in the spaces provided.

3. When you are done, click Search the Shop .  The search results are displayed on the right.
If no products are found, the message “No products match search criteria” is displayed.

Selecting an Item to Buy and Browsing for More

Once a customer finds a product that he/she wants to buy, he/she clicks on the Buy button.

By clicking on the Buy button, the customer is automatically brought to his/her shopping cart.
Here, the system identifies how many items are in the shopping cart, what each item is and
allows the customer to specify the quantity that they want to order.

If the customer wants, he/she can immediately return to the Shopping page by clicking on the
Keep the shopping cart and shop for more  button.  The shopping cart will continue to store
the customer’s selections until the purchase order is placed.  Even if the customer leaves your
WebStore, the shopping cart entries remain in your WebShop database.  That means, that when
the customer returns (from one minute later up to one week later) using the same PC, all of the
those purchase selections are still available.

• Perform a product search using the Product Search Tool.

• Go to the company information page, by clicking on the Company Information  navigation
bar.

Using the Product Search Tool
A customer can specify what items they want to see by using the product search tool.  They can
search on product name or product description using two qualifiers; equals or contains.  They
can also search based on product price using a price between qualifier.

To search on product name or description

1. Select the type of search you want from the drop-down list.

2. Specify the search value (for example, to search for the word bedding, type Bedding in the
space provided.)

3. Select a qualifier to use during the search:

• If you want product names or product descriptions that equal the value “Bedding ,”
click the Equals  radio button.

• If you want product names or product descriptions that contain the value “Bedding ,”
click the Contains  radio button.
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Every time the customer clicks on the Order  button, he/she will return to the shopping cart
where they can review their current selections.

To return to the shopping cart without clicking on the Order  button, look for the link View
Shopping Cart on the Company information page .

Specifying Quantities from the Shopping Cart

By clicking on the Order  button, the customer is automatically brought to his/her shopping cart.
Here, the system identifies how many items are in the shopping cart, what each item is and
allows the customer to specify the quantity that they want to order.

The customer can also recalculate the total amount of the order if they change the quantity
ordered.  To begin the order process, the customer should click on the Proceed with Order  text
link.  If the customer decides not to purchase an item, he/she can remove the item from the
shopping cart by removing confirm check mark in the Confirm  check box and pressing the
Recalculate  button.
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Features that your customer will see:
• The Shopping Cart header tallies the total number of items currently in the shopping cart.

• Each product line contains a Quantity  and Confirm  field.

• Each product line specifies, Product Code, Name , Description , and Unit Price .

• There are two text links: Keep the shopping cart and shop for more  and Proceed with
Order .

Actions that your customer can take:
• Specify quantities to be purchased

• Delete items from the cart

• Recalculate the total amount of the order

• Keep the shopping cart and shop for more



E-Commerce User Guide 2–11

Chapter 2.  What Your Shoppers See and Do

Getting Customer Information

The first step in the order process is to gather customer information.  Up until this point, the
customer has been browsing and selecting products to buy.  Now they are preparing to complete
the order.

If the customer is new, the Customer Billing Information  page is blank.  He/she must complete
the Customer Billing Information  page to continue.  If the customer has registered previously,
then the previously entered values are displayed.  By re-displaying these values, the system is
also allowing the customer to update the information, if necessary.

The buttons displayed at the bottom of the form reflect differences in a customer’s registration
status.  If the customer is new, the only buttons that display are Enter Customer Information
and Cancel .  If the customer is already registered then the Order Now  button is added and the
Enter Customer Information  button is changed to Update Customer Information .  When a
new customer registers for the first time, they must first enter their data.  After it is entered, the
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customer then waits until the Order Now  button is displayed.  By delaying the display of the
Order Now  button until after registration is complete, WebShop is ensuring that all customers
are registered before they can continue the order process.

Features that your customer will see:
• The form title, Customer’s Billing Information

• Individual fields for First Name, Last Name, Company, Address, City, State, Country ,
Postal Code, Phone , and Email

• The Enter Customer Information  or the Update Customer Information  button

• The Reset  button which cancels and the changes and returns the Customer’s Billing
Information  to its original state

• The Order Now  NavBar button which moves the customer to the next step in the Order
Entry process

• The Continue Shopping  text link that returns the shopper to the Shopping page.

Actions that your customer can take:
• Enter data onto the form

• Reset any changes made

• Enter or update customer information

• Continue shopping

• Proceed to the next step in the Order Entry process

Specifying Shipping Details and Payment Method

After collecting customer information, the next step in the order process is specify shipping
details and a payment method.  By clicking Order Now , customers are prompted to enter this
next level of order detail.

The Order Now page performs a number of operations:

• Places, by default, customer information into Shipping Information (Where to Ship)
fields.  To ship orders elsewhere, customers can change this data by selecting these fields
and over-writing the default information.

• Places, by default, the shipping method specification Ground  and displays the shipping
cost associated with that method.  If a customer decides to change the default shipping
method, they must first select a new method from the drop down list and then use the
Recalculate Shipping  button to recalculate the invoice amount based on the new shipping
method.  The only shipping methods that a customer can choose from are the ones you (as
WebStore merchant) set up.
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• Places, by default, a Master Card method of payment.  Customers can change the payment
method specification, as necessary, by selecting a new method from the drop down list.
The only payment methods that a customer can choose from are the ones you (as WebStore
merchant) set up.

Features that your customer will see:
• The ordered products are listed in the section top along with a Selected Shipping  Method

field (with a drop down list of methods from which to choose).

• A Subtotal  and Grand Total  summary of charges.

• A Recalculate Shipping  button to recalculate shipping charges, if the shipping method is
changed.

• A Continue Shopping  text link to enable shoppers to exit the Order Entry process.

• A View Shopping Cart  text link to enable shoppers to re-specify an item or quantity
ordered, if necessary

• A Shipping Information (Where to Ship)  section to record shipping details in the bottom
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right section.

• A Payment Method  field (with a drop down list of methods from which to choose).

• A Submit This Order  button to move to the next step in the Order Entry process.

Actions that your customer can take:
• Select a new shipping method, or accept the default

• Recalculate the shipping method charges, if they change the shipping method default

• Select a new payment method, or accept the payment method default

• Specify a new shipping information or accept the customer information default

• Go back to the Shopping Cart if they need to re-specify an item or quantity ordered

• Return to the Shopping Page if they want to exit the Order Entry process

• Continue with the Order Entry process

Submitting the Order for Transaction Processing

After the customer specifies the shipping details and payment method, he/she still has to enter
credit card details.  At this point, the customer is taken to a secure Web server linked to a
financial processing center.  This financial processing center verifies customer charges and
arranges for the deposit of funds into the merchant’s account.

Features that your customer will see:
• The label Order Form at the top of the screen

• Applicable data from the previous entry screens carried over by default.

• An Account Number  field with the instruction No Spaces or Dashes

• Separate fields for credit card expiration  Month  and Year.  These fields have drop-down
lists to make data entry consistent.

• The total purchase amount is displayed.  This field cannot be overwritten.

• Only one navigation button—Continue .  Customers who want to discontinue the order
entry process at this point must click the Back  button on their browsers or enter a new
URL.

• The secure site icon in the status bar.  This identifies the site as a secure site.
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Actions that your customer can take:
• Enter a credit card account number and expiration date.

• Click the Continue  button to move forward in the order entry process.

• Click the Back  button on his/her browser to discontinue the order entry process.

If customers fail to enter the details completely, the message “Form Entries Incomplete or
Invalid ” is displayed along with some instructions on how to return to the order form.
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Reviewing the Order Prior to Payment

After recording their credit card details, customers are given one more opportunity to review the
order information.  If they need to correct any of their credit card details they must press the
Back button on their browser to return to the previous order form.  If they want to abandon the
order they simply have leave the Web site without clicking on the Submit Order button.

The instructions provided on this page are as follows: “Please review this information carefully
before pressing the Order  button below to submit your order.  If the information above is
correct, please click the Order  button below once to submit your order.  Clicking the Order
button multiple times will result in multiple  charges to your credit card.  This process may
take up to 60 seconds.  Please wait .”

Features that your customer will see:
• The label Final Order Review at the top of the screen.

• Applicable data from the previous entry screens carried over by default.   Customers cannot
over-write this data.
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• One navigation button—Submit Order .  Customers who want to discontinue the order
process at this point must click the Back  button on their browsers or enter a new URL.

• The secure site icon in the status bar.  This identifies the site as a secure site.

Actions that your customer can take:
• Accept the order as presented by clicking Submit Order .

• Reject the order as presented by clicking the Back  button on their browsers.

Receiving Online Confirmation

Once customers press the Submit Order  button, the button changes to say Processing !

At this point, any one of three things can happen:

• If the order is successful, a confirmation message is displayed.

• If the order is unsuccessful, the message Order Declined  is displayed.

• If a processing timeout occurs, the message Timeout occurred.  Try again later is dis-
played.  This is an automatic message informing the customer that the order could not be
processed due to a system overload or an Internet traffic jam.  This form includes two text
links: Back to Home Page  and Continue Shopping .  These will ensure that any customer
receiving this message can easily return to your WebStore.

Email Confirmations

Once an order is confirmed online, email confirmations are sent to both the customer and the
merchant.  These confirmations originate from the merchant Web site.  Since both of them are
important, they are covered here.

Customer Confirmation
A customer confirmation is emailed automatically by your WebStore server to your customer’s
email address—this confirms that the order was accepted, restates the shipping instructions,
supplies an order ID, and restates the order details.  The total order amount including taxes and
shipping is also provided.

Features that your customer will see:
• The subject line of the email is Thank you for your purchase .

• The customer’s name is identified in the opening salutation.

• The statement Your order was accepted  appears at the top.

• The shipping information provided.

• The order number is provided.

• Order details, including product ID, product name, unit price, and quantity are provided.
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• The total order amount including taxes and shipping is also provided.

• Proceed with the order.

Merchant Confirmation
The merchant confirmation—confirms that one more order was successfully process, restates
the shipping instructions, supplies an order ID, and restates the order details.  The total order
amount including taxes and shipping is also provided.

Note: There is also an important Legal Notice and Agreement section.  This section identi-
fies liability limitations and should be read carefully.

Features that you, as merchant, will see:
• The subject line of the email is One more order’s been successfully processed .

• The statement One more order was successfully processed  appears at the top.

• The shipping information provided.

• The order number is provided.

• Order details, including product ID, product name, unit price, and quantity are provided.

• The total order amount including taxes and shipping is also provided.

• A legal notice regarding liability limits is provided.

The text for the legal notice and agreement sections is provided in full below:

By accepting this order or processing into, you as the seller or merchant or person, take
upon you the full and complete responsibility of its accuracy and any liabilities, costs,
losses, that may arise due to many factions which are part of the internet and the way data
is transmitted, there is no guarantee that the data on this order has not been tampered with
or changed prior to your receiving it.

Carefully examine the order and all its details including the shipping information, the
products being purchased or alleged to be purchased, as well as and in particular the prices
and the total amounts of the order.  Make sure that everything is accurate, especially that
the products purchased and the prices and the totals noted match one another and agree
with your business pollices, prices and information.

Do not ship any products to any buyers if you are in doubt.  Pursue any avenues that are
available including calling the buyer and resolving any issues or discrepancies.  By process-
ing this order or shipping the products mention to any entity or person, you agree to the
terms mentioned herein, and you waive any rights whatsoever against Boomerang Software
Inc.  or its agents and you hold Boomerang Software and its agents harmless from any and
all damages, losses, opportunity costs, actual costs, legal costs or consequential costs.

This notice and agreement herein supersedes any and all other communications or agree-
ments between Boomerang Software, its agents and you, your company or any merchant or
user using this service or product.



Chapter 3.
Customizing an E-Commerce
Template

Introduction
Since most of the E-commerce pages are built using the E-commerce templates, you won’t want
to make many customization changes.  However, if you do, let’s cover the most common ones
right now.  Some of what is introduced here may be new to you—particularly if you haven’t
already read the WebShop User Guide.  Don’t worry though!  Nothing here is all that hard.

Topics covered in this chapter include:

• What are E-Commerce Templates?

• E-Commerce Templates and the Physical and Logical Layout

• Importance of Dynamic Pages and Customization Limits

• Predesigned Template Links

• Replacing the Placeholder Text

• Adding a New Home Page

• Changing Your Default (or Inherited) Style

• Warning Your Customers to Configure for Cookies

• Changing Your StoreFront’s Scrolling Text

What are E-Commerce Templates?
To make E-commerce functionality a reality, WebShop has several E-commerce templates and
a WebShop Wizard.  The E-commerce templates are Predesigned Web pages containing default
data, which you can use to explore WebShop and begin to think about how you might want to
use WebShop.  These templates are the starting points for setting up your own WebStore.

To help you set up the required database and complete merchant registration, WebShop has a
WebShop Wizard.  This Wizard is essential to setting up your database of products and product
categories.  The end-result of opening an E-commerce template and running the WebShop
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Wizard is a set of physical files that contain your E-commerce related Web pages and all the
administrative and product data that you entered when completing the Wizard.

E-Commerce Templates and the Physical
and Logical Layout

You should know that your entire Web site is stored, physically, within one project folder, and
that WebShop stores all of the necessary information (including supporting graphic and/or
multimedia files) in a single WebShop file format (with extension *.cnq).  And more specifi-
cally, your E-commerce WebStore is stored, physically, within one subfolder labeled WebStore.
This makes managing your E-commerce Web site much easier during development.  When you
go to generate the Web site, by uploading it to your ISP server, WebShop automatically splits

the CNQ file apart into the necessary configuration of files and folders.

After running the Wizard, look at the physical layout of your Web site, there are several
subfolders (three or four depending upon the E-commerce template used) within the WebStore
folder along with one Web page file, Index.htm .  Two of these subfolders, the Admin folder
and the Database folder, are common to all E-commerce templates.  This is the standard file
configuration for your WebStore.  The Admin folder contains the dynamic page associated with
WebShop’s Database Administration feature.  The Database folder contains the single database
file (with extension *.MDB) used to maintain your WebStore database.  By default, this file is
named ShopDB.mdb .
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Now, look at the logical layout of your Web site.  The default Home Page is your StoreFront
page.  The physical file name for this page is Index.htm .  When designed, the StoreFront page
created by any one of the WebShop E-commerce templates was intended to be the Home Page
for your site, but you can change that.

Note: It is important that you use the physical file name index.htm for only your Web site
Home Page.  So if you add additional pages in front of your StoreFront (which means you
will be setting up a new Home Page), be sure to rename your StoreFront file and change the
Home Page physical file name to Index.htm.

It is highly recommended that you leave the physical and logical structure of the E-commerce
part of your Web site untouched—that is, the logical structure of the various pages should not
be touched and the physical placement and naming of these files within the WebStore subfolder
should not be changed.  That doesn’t mean that you cannot add new pages.  It only means that
the physical and logical placement of those new pages cannot interfere with the functioning of
your E-commerce pages.  So, here are a couple of rules to remember:

• You should not add any logical pages below your StoreFront—only above it.

• You should not move, rename, or delete any dynamic pages that make up your WebStore.

• You should not move, rename or delete any of the E-commerce physical files from the
physical layout.

• You should not add or change any files contained in the Database folder.



Chapter 3.  Customizing an E-Commerce Template

3–4  E-Commerce User Guide

Predesigned Template Links
You may want to redesign one or more of the elements on your StoreFront.  To accomplish this,
you must be aware that there are three specific links that you must keep—

• One links your StoreFront to Shopping  so that customers can go shopping;

• Another links your StoreFront to CompanyInfo  so that customers can learn about your
company; and

• The last one links your StoreFront to Administration  so you can update your database
once you have uploaded it to your ISP.  The Administration link enables the Database
Administration feature that comes with WebShop.

Any Predesigned template link has an associated Web page that is stored in the WebStore
folder—on your hard drive, once you open an E-commerce template.

Note: For the OneProduct template called Michelle’s Oil Creations, there are a total of five
text links.  To identify these links, look for blue text with an underscore:

1.  “Get to know Michelle” links the StoreFront to GetToKnow .
2.  “Her training, art reviews, exhibits” links the StoreFront to Training .
3.  “Buy a Masterpiece” links the StoreFront to Shopping .
4.  “Michelle’s Oil Creations” links the StoreFront to CompanyInfo .
5.  “Framing recommendations” links the StoreFront to Framing .

There is also one graphic link (scroll down to the bottom of the page and look for an Artist’s
palette image).  This graphic image links the StoreFront to Administration, which is to be
used by the store owners, not by shoppers.  This link can be deleted with causing a
problem.

Replacing the Placeholder Text
Once you have opened your template and have run the Wizard, you will find that your Store-
Front page contains generic text that you will want to customize.

Note: This section uses the OneProduct template called Michelle’s Oil Creations.

After running the Wizard, WebShop returns you to the Site Manger  window on the left and the
Page Editor  window for the WebStore page on the right.  This is your starting place.  From
here, you will customize your template by replacing the generic placeholder text with some-
thing more specific.

To replace the placeholder text found on the StoreFront page

1. Maximize the WebStore  window.  Notice the Frame and Page Editor toolbar at the top of
the WebStore window.  Use this toolbar to add frame overlays and to toggle between
Frame Manger and Page Editor.

2. Click on any text.  Notice that a placeholder outline appears and the cursor is now an arrow
with a gray square.  This is the Object Selection cursor.  With this cursor, you can move the
object around the page.
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3. Double-click on any text.  Notice that the placeholder outline is now open at the bottom
and a blinking cursor is positioned at the right edge of the text.  This is your Text Insertion
cursor.  Also, notice that the Standard toolbar appears.  Use this toolbar to make font
changes or to assign paragraph styles.

4. Double-click on the text “Template hint: ”

5. With the insertion cursor at the start of the text box, type “ <my new text>”  Notice that the
existing text is moved to the right.

6. To delete the existing text, click and drag your insertion cursor over the text you want to
delete to select it and press DELETE.

To assign a different text style

1. Double-click on the text “Buy a Masterpiece .”

2. Select Format > Paragraph  or click on the Paragraph  button on the Standard toolbar.
Notice that the current style assignment is Head4.

3. Using the drop down list box, select the paragraph style that you want to use and click OK.

Depending upon the style you choose, you may need to resize the text box so that all of the text
is displayed.

To resize a text box

1. Click on any text to display the text box outline.  Notice that your cursor is now an Object
Selection cursor.

2. Move your cursor to one of the text box handles.  Notice that your cursor is now a Resize
cursor.

3. Click and drag one of the text box handles to make the object bigger or smaller.

4. Release the mouse to set the size you want.

To replace the banner text

Banner text is different from display text.  To change banner text you must change the Alias
text for the page resource using the Properties dialog box.

1. Click the Page Properties  button on the Frame and Page Editor toolbar.  The Properties
dialog box for the page resource Index.htm displays.

Note: The logical page name (WebStore) is not the same as the physical page name
(Index.htm).  When replacing banner text you are replacing the Alias text for the physical
page (Index.htm)

2. Click and drag to highlight the text Michelle’s Creations .

3. Type “ <my new banner>” to replace the highlighted text.

4. Click OK.
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To view the new banner text

Once you have changed the banner text, you must refresh your window display.

1. Select Window > Site Manager  to return to the Site Manager–Logical Layout  window.

2. Select Window > WebStore  to return to the Page Editor  window for WebStore.  WebShop
has updated your banner text.

To replace the central image

1. Click on the painting graphic.

2. Right-click and select Properties from the pop-up menu.  The Image Attributes  dialog
box appears.  Use this dialog box to replace a one of the StoreFront images with a new
image.

3. Decide what type of image you want to use:

• If you want an image that is a current resource, select the Existing Resources  tab and
select the image you want from the list of available resources.  Choose an image by
clicking on physical resource name.

• If you want a Library image, select the Library tab and select the image library that
you want from the drop down list box.  Choose an image by clicking on it.

• If you want to use an image from the Internet, click URL tab and type the exact URL
address for the image.

• If you want to Import an image from your hard disk, click Import button.  The Import
dialog box appears.  Navigate to the appropriate directory location and click on the file
you want to use.  The file you selected is now highlighted as an existing resource.

3. Click the Preview  check box to view a preview.

4. When done, click OK.

To replace the placeholder text for a text link

1. Double-click on the text “Buy a Masterpiece ”

2. With the insertion cursor at the start of the text box, type “<my new text>”  Notice that the
existing text is moved to the right and is displayed in a different color.

Note: Text links are displayed in blue text.  Your new text does not carry a hyperlink.

3. To delete the existing text, click and drag your insertion cursor over the text you want to
delete to select it and press DELETE.

To assign a link to new text, or reassign a text link to an different resource

1. Double-click on the text box that you want to contain the link.  Notice that all of the text in
the text box is highlighted.

2. To highlight selected text only, click and drag the cursor over your text selection.

3. Select the Insert > Link  menu options or click Insert Link  from Insert Objects  toolbar.
The Link  dialog box appears with the To Page tab activated.  The list of available pages
appears.



 E-Commerce User Guide 3–7

Chapter 3.  Customizing an E-Commerce Template

4. Select the Web page to which you want to link.  For example:

• If you want to replace the shopping link, select Shopping.

• If you want to replace the company information link, select CompanyInfo.

• If you want to replace the database administration link, select Administration.

Note: The To Resource tab lists the physical names of individual pages or frames in the
resource tree window, while the To Page tab lists the logical names for these pages.

5. When done, press OK.

Adding a New Home Page
Suppose you really want to include on your Web site, a page for press releases, a “contact us”
email form, and an employment opportunities page.  How are you going to add this additional
material?  To do this you should add a new Home Page and set up separate departments for
each area you want to introduce.  In this case, your WebStore simply becomes a “stand alone”
department within a much larger Web site.  Now you can make as large a Web site as you want
and leave the E-commerce dynamic pages alone.

To add a new Home Page and some additional Web pages to the front-end of your
E-commerce Web site

1. Open Site Manager and click Logical Layout tab.

2. Without selecting any of the objects displayed, right-click the open area white space.
A pop-up menu appears.

3. Select New Home Page  menu option.  Add Logical Page  dialog box appears.

4. Decide if you want to create new resource or use an existing one.

• If you want to create a new resource, click Select Resource Type tab and select a
resource type for the new resource.

• If you want to use an existing resource, click Use Existing Resource  tab and select the
resource you want to use.

5. Repeat this procedure to make another Home Page above the current one as many times as
necessary.  When done, click OK.

Once you have created your new Home Page be sure to rename your old Home Page and name
the current one Index.htm.  You can now add additional child and sibling pages below your new
Home Page, by selecting new Home Page and clicking the New resource button from the
Logical Layout toolbar.  From the Add Logical Page dialog box, specify the type of pages you
want to add.  You will now want to think about how best way to link your pages together once
you have created these additional resources.  Be sure to make a link from your new Home Page
to the StoreFront.
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Changing Your Default (or Inherited) Style
Each E-commerce template comes with one or more specific styles.  When you create a new
Home Page, the previous Home Page’s default style becomes the inherited style for the new
page.

To change the default (or inherited) style for your New Home Page

1. Select the new Home Page from Logical Layout  window and right-click it.  The pop-up
menu appears.

2. Select Styles  option.  The Page Style dialog box appears.

3. Decide if you want to use one of the available specific styles or create a custom style.

• If you want to use a specific style, click Specific Style  radio button and select the
style you want from the drop-down list.

• If you want to create a custom style, click Specific Style  radio button and select the
style that comes closest to what you want from the drop-down list, then click Custom
radio button and modify the style as necessary.

Note: Specific Styles must already have been inserted into the Site Styles listing before they
are available for selection.  The procedure for inserting Site Styles and for modifying a style
is also in the WebShop User Guide, see the chapter titled “Dynamic HTML and Cascading
Style Sheets.”

4. When done, click OK.

You can also change your default style from the Styles tab in Site Manager.  To do this, select a
new style from the style library and insert it into the available site styles listing or create one of
your own.  Then assign it as your default style.  Any site resource assigned to the default style
will assume this new style.

Note: Once you change the default style for your new Home Page, every child or sibling
page that you subsequently create will by default inherit that style.

Warning!  When changing your default style, if you want your E-commerce dynamic pages
to carry the same style, be sure to copy and rename your default style “ECStyle.” Your E-
commerce dynamic pages use this style as a specifically assigned style.  There must always
be at lease one style in the styles list with the name “ECStyle,” which may be the same as
your default style.

Changing the ECStyle for an E-Commerce Template
Every E-Commerce Template comes with two predefined Site Styles: Default Style and
ECStyle.  The Default Style is a basic very style. Use it to practice making style modifications.
It is not the default style for your template.  When opened, each page in your template uses
ECStyle.  ECStyle is the default style for your E-Commerce Template.  To change ECStyle, you
must decide if you want to replace ECStyle with an entirely different style sheet or if you want
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to modify one or more of the style sheet elements.  Both of these are important options.  One
gives you an entirely different look to your Web site and the other only modifies the look that
you already have.

To begin working on styles

• From Site Manager, click the Styles tab.  The Site Manager—Style window appears.

This dialog box is used to define styles for use with your Web site.  It has three parts:  Styles
Library  list box and listing area, a Site Styles  display area and a Preview  area.   By default, the
Styles_A  Style Library is selected.  Click Styles_A01 to see a preview.  By previewing styles
from the Style Library, you can decide which of the predefined style sheets you want to use.
Once you select a style you want, insert it into the Site Styles list.

To insert a Library Style into the Site Style list

1. Highlight on the style you want and right-click.  A pop-up menu appears.
2. Select Insert Style .

The style you selected has now been inserted into the Site Styles  display area.  It is now
available for use.  You can insert as many Library Styles as you want.  If you do not like any of
the Library styles, you may also create a Custom Style.

To create a custom style

1. Right-click in the Site Styles  box (in the white space).  A pop-up menu appears.

2. Select New Style .

Making a new style creates a copy of the Default Style.  By default, any custom style based on
Default Style is named Style , Style1 , Style2 , successively.  You should rename your custom
styles so they have a distinctive name, one that tells you how that style will be used.

To rename a style

1. Highlight the style you want to rename and right-click.  A pop-up menu appears.

2. Select Rename .  A box appears around the style name.

3. Type the new name.

Once you have renamed the style, you are ready to customize the style.

To modify (or customize) a style

1. Highlight the style in the Site Styles list.

2. In the preview area, select and double-click on the style element that you want to modify.

Note: Style previews are divided into different areas.  You may want to experiment with
several just to learn how style elements are grouped.  For example, highlight the word
“Banner” (dotted lines appear) and double-click the box.  The Banner Style  dialog box
appears.

3. From the dialog box that appears, choose the options you wish to change.
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Note: There are five dialog boxes that might open depending upon what style elements you
select.  These include NavBars, Headings, Font Styles, Bullets and Numbering.  To change
a style, you may need to play with the various options used with each of these dialog boxes
to see just how they work.

4. When you are done, click OK.  Your change is now reflected in the preview area.

Note: If you want to use a custom image for a banner, bullet, or other graphic object, you
can insert new images into the one of the several image libraries.  You can do this by
selecting on Library > Edit  Image Library .  The Edit Library  dialog box appears.  Use the
drop down menu in the Library Type  box to select the library.  Then locate the image that
you want to add in the top most Look In  box.  Highlight the image file that you want and
click Add .  When done, click OK.  When you go back to insert the graphic image, the image
will be there.

You can customize all of the different sections of the Style sheet using the above procedure.
The editable parts of the Style sheet include NavBars, Headings, Font Styles, Bullets and
Numbering.  When done, you might want to set one of your customized Site Styles as the
Default Style.

To set one of the site styles as the default style

1. Highlight the style that you want to be the default and right-click.  A pop-up menu appears.

2. Select Set as Site Default Style .  A red check mark appears next to the icon for that style
sheet.  This indicates that it is the default style.

Note: When changing the default style for an E-Commerce Template, you must use the
name “ECStyle.”  Your E-commerce dynamic pages use this style as a specifically assigned
style.  There must always be one style in the Site Styles listing called“ECStyle.”   You may
assign other pages different styles with different names, but to function properly, your
WebStore’s dynamic pages must be set to ECStyle.

Warning Your Customers to Configure for Cookies

Right now, customers cannot shop at your Web site anonymously.  In technical terms this
means that to shop, customers must have browsers that accept cookies.  Now you might be
asking: “What’s a cookie?” Cookies are User IDs automatically generated from the server side
(that is, from your Web site) and deposited in a customer’s PC.  When a customer first enters
your WebStore, a cookie is generated and deposited on their hard-drive.  They are now uniquely
identified to your WebStore.  Without this unique identification, your WebStore is unable to let
a customer browse through the merchandise.  Customers who are not configured for cookies
will receive a warning message whenever they try to go shopping.

To prevent this from happening, you will want to make sure to inform your customers that they
must configure their browsers to accept cookies.  By default, both Microsoft Explorer and
Netscape Navigator accept cookies.  So for most of your customers this will not be a problem.
Right now, all of the E-commerce templates have a warning message on the StoreFront.  You
may want to go further and put a link that takes them to specific instructions on how to config-
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ure their browsers.  If so, you will want instructions for Internet Explorer and Netscape Naviga-
tor, the two most common browsers currently on the market.

To configure a Microsoft Explorer for cookies (version 4.0)

1. Select View > Internet Options from the Main Menu.  Internet Options  dialog box
appears.

2. Click Advanced  tab.

3. Scroll down to Always Accept Cookies  check box.

4. Click in the check box.  A check mark displays when the option is active.

To configure a Netscape Navigator for cookies (version 4.0)

1. Select Edit > Preferences from the Main Menu.  The Preferences  dialog box appears.

2. Click the Advanced  category from the category listing.  The Advanced  dialog box appears
on the right.

3. Look for the section titled Cookies .

4. Click the first radio button option, Always Accept Cookies .  When selected, the option is
active.

Changing the Buy Buttons
The Buy button used with your Shopping.htm page is “hard-coded” on five Active Server Pages
(resource files with the extension, *.ASP).  Should you decide to replace the Buy button with an
image of your own, you must make the replacement in five distinct locations.  You may import
an image of your choosing one time and use it to make multiple replacements.

To change the buy button on Products.asp

1. Open your Web project.  Select the Physical Layout  tab.  Locate the Web page
Products.asp  in the WebStore  folder.  Double-click on the file icon.

Note: The Dynamic page opens in Edit mode, automatically opening in a dual-frame format.
The left window contains the Dynamic Page control settings.  This window is called the
Dynamic Page Manager window.  You do not need to understand the control settings to
complete this task.  The right frame is grayed out.  You may widen the Dynamic Control
window if it is too narrow.

2. In the Dynamic Page Manager  window, locate and click on the Edit Products View  icon
at the bottom of the Dynamic control item listing.  The right window immediately displays
a table containing the Buy button in the lower right cell.

3. Click once on the table to select it.  Click once more on the cell containing the Buy button.

4. Select Format > Object > Properties  from the main menu or right-click and select
Object > Properties  from the pop-up menu.  The Image Attributes  dialog box appears.

5. In the Image Resources  section, select Import.  The Import  dialog box appears.

6. Using the Look In  section of the Import  dialog box, browse to the drive or folder contain-
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ing the image you wish to use for your Buy button.

7. Select the image and select OK.  The Image Attributes dialog box reappears, with the new
image previewed (if the Preview image check box is checked).

8. In the Image Resources  section, the new image appears in the Existing Resources  list,
highlighted in gray, signifying its eligibility for use in your Web site project.  You do not
need to import this image again.

9. Select the new image file name.  Click on OK.  The Dynamic page Products.asp  reap-
pears, displaying the new image in the table, replacing the previous Buy button image.

Replace the Buy button in the four remaining locations—all of which are located on the
Dynamic page SearchNow.asp .  To do this, locate the following  four controls listed in the
Dynamic Page Manager window.  These are 1. Contains_Product Name , 2. Contains_
Product Description , 3. Equals_Product Name , and 4. Equals_Product Description .

To replace the four Buy Buttons from SearchNow.asp

1. From the Site Manager–Physical Layout window, locate the Dynamic Web page
SearchNow.asp  in the WebStore  folder.  Double-click to open this page.

Note: The Dynamic page opens in Edit mode, automatically opening in a dual-frame format.
The left window contains the Dynamic Page control settings.  This window is called the
Dynamic Page Manager window.  You do not need to understand the control settings to
complete this task.  The right frame is grayed out.  You may widen the Dynamic Control
window if it is too narrow.

2. Locate and select the control item Contains_Product Name .  Immediately a table appears
in the right frame displaying the Buy button in the lower right hand cell.

3. Select the table by clicking once.  Click once more to select the Buy button.

4. Select Format > Object > Properties  from the menu bar or right-click and select Object >
Properties  from the pop-up menu.  The Image Attributes  dialog box appears.

5. In the Existing Resources  list box of the Image Resources  section, locate the new image
you just imported in the procedure above.  Select that image file name.  Click OK.  The
new image is now assigned to the Contains_Product Name  control.

Follow Steps 2–5 to replace the Buy button in the remaining three control items
Contains_Product Description , Equals_Product Name , and Equals_Product Description .
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Introduction

WebShop comes with a specialized E-commerce menu.  When you are working with a standard
Web site (that is, a Web site that does not include E-commerce functionality) this menu is not
available.  Only if you open one of the E-commerce templates and complete the WebShop
Wizard does this specialized menu appear.  The options on this menu allow you to change your
database information.

Normally, when you start a new E-commerce site by opening an E-commerce template, the
WebShop Wizard comes up. This Wizard displays a series of dialog boxes where you enter
information, configure your store setting and create your database of products for sale.  For
more information, see the chapters titled “WebShop Wizard—Building Your Administrative
Database” and “WebShop Wizard—Building Your Database of Products for Sale” in this
manual.

However, once you have completed entering data using the Wizard, you may want to update
this information at a later time.  Rather going through the Wizard again, the E-commerce menu
makes it easy to make changes to your initial data entry by accessing the data using the same
dialog boxes.

Topics covered in this chapter include:

• Initiating Merchant Registration

• Updating Company Information

• Updating Payment Methods

• Updating Shipping Methods

• Updating Products
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Initiating Merchant Registration

You can initiate merchant registration either from within the WebShop Wizard or from Site
Manager by selecting the E-Commerce > Merchant Registration  menu options.  In both cases,
you are brought to the Merchant Registration  dialog box.  From here, you must confirm that
you want to continue.  If you choose to continue, WebShop automatically launches your
preferred browser where you will complete merchant registration online.

To initiate merchant registration

1. Select the E-Commerce > Merchant Registration  menu options. The Merchant Registra-
tion  dialog box appears.

2. Decide how you want to proceed:

••••• If you want to continue the registration process, click Continue .  WebShop will launch
your system’s preferred browser and access the merchant registration Web site.

• If you do not want  to continue, click I’ll Register Later .  WebShop either will advance
to the Company Information  dialog box (if you are still in the Wizard) or return you to
the Site Manager-Logical Layout  window (if you are completing registration from the
E-commerce menu).

3. With the Registration screen displayed, specify whether you already have a merchant
account and complete the required pre-registration information.
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4. When done, click Continue . Your browser will automatically access the next merchant
registration Web page.

5. Select the service options that you want.

Note:  The default service options are Apply for a New Merchant Account and Set Up
Electronic Payment Processing.  The terms associated with each option are displayed.

6. When done, click Submit Registration . You are prompted for merchant demographic
information.

7. Complete the merchant demographic information. Whatever data you entered earlier, on
the Registration  screen, defaults here.

8. When done, click Submit Registration . You are prompted for payment information.

9. Complete the payment information fields.

Note: You do not have to have a valid credit card account to qualify as a merchant and
receive processing services.  If you have questions about payment options, contact the
financial processing center directly.

10. When done, click Submit Payment Information . The financial processing center displays
all registration information and calculates the amount charged to your credit card.  If you
need to change any of this information, press Back on your browser.
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11. Once everything is correct, click Submit Order .  A confirmation message is displayed with
your Store ID number and the password that you supplied.

Note:  You must write down your Store ID and password to complete the WebShop Wizard.
Record both of these values when entering the Company Information dialog box.  Also, to
obtain access to your administrative page, where you perform database administration
procedures, you must enter these values (see the chapters titled, “Database Administration
by Merchant” and “Maintaining Security and Backing up Your Files”).

Once you have received your confirmation message, you have completed the merchant applica-
tion. You should now return to the WebShop program so you can continue working from the
Site Manager window.  You will be contacted regarding your application.
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Updating Company Information

You can update your company information by selecting the E-Commerce > Company Infor-
mation  menu options.  This brings you to the Company Information  dialog box.  To learn
more about what is recorded in the Company Information dialog box and how this information
is stored within your E-commerce database, see the chapter titled “WebShop Wizard—Building
Your Administrative Database.”

To update company information

1. Select the E-Commerce > Company Information  menu options. The Company Informa-
tion  dialog box appears.

2. Specify (or select from a drop-down list) the following field values, as necessary, to update
your company information: Company Name , Address, City, Zip/Postal Code, State/
Province, Country, Phone Number, Fax Number,  and Email address. To select a field,
click on it. The existing data is highlighted.  To overwrite this information, type the new
information once the existing data highlighted.

3. Type the Store ID  and Password  for your store if you have not already done so.

• If you completed merchant registration, enter the Store ID that you were given during
the registration process and the password that you have assigned to your store.

• If you did not complete merchant registration, leave the default value (10002) for
Store ID and enter a password. You may use Store 10002 as a test WebStore.
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Note:  Be sure to write this password down.  You will need it later when you complete
registration.

4. In the Sales Tax Rate  section, specify how you want WebShop to calculate sales taxes if
you have not already done so.

• If you want to calculate sales taxes for customers who are in your state, click on the In
State/Province  radio button.

• If you want to calculate sales taxes for all customers no matter where they live, click
on the In Country  radio button.

Note: The general rule is that if you are selling products to a customer who is in the same
state as you (the merchant), then your state’s sales tax rate applies.  For this type of sales
tax calculation, select the “in state” option.  If you want to apply one sales tax rate to all
customers in the US, select the “in country” option.

5. In the Sales Tax Rate  section, specify the sales tax rate to apply in the Value  field.

6. When done, click OK.  If you do not wish to record your updates, click Cancel .

Updating Payment Methods

You can update your payment methods by selecting the E-Commerce > Payment Methods
menu options.  This brings you to the Select Payment Method  dialog box.  To learn more
about what is recorded in this dialog box, including what type of payment methods you can
select, how they impact your customers, and how this information is stored within your E-
commerce database, see the chapter titled WebShop Wizard—Building Your Administrative
Database.

To update your payment methods

1. Select the E-Commerce > Company Information  menu options. The Select Payment
Method  dialog box appears.

2. Place a check mark next the payment methods that you intend to offer.

• To place a check mark, click on the check box next to the payment option.

• To remove a check mark, click on the check mark next to the payment option.

Note:  The options you select must agree with the services that you purchased through your
financial processing center.

3. When done, click OK.  If you do not wish to record your updates, click Cancel .
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Updating Shipping Methods

You can update your shipping methods by selecting the E-Commerce > Shipping Methods
menu options.  This brings you to the Shipping Methods and Prices  dialog box.  To learn
more about what is recorded in this dialog box, including what type of shipping methods you
can select, how they impact your customers, and how this information is stored within your E-
commerce database, see the chapter titled “WebShop Wizard—Building Your Administrative
Database.”

To update your shipping methods and prices

1. Select the E-Commerce > Shipping Methods  menu options. The Shipping Methods and
Prices  dialog box appears.

2. Place a check mark next the shipping methods that you intend to offer.

• To place a check mark, click on the check box next to the shipping option.

• To remove a check mark, click on the check mark next to the shipping option.

3. Select the calculation method you intend to use when calculating shipping costs.

Note:  There are three calculation options: a Flat Rate option, which assigns a flat rate



Chapter 4. E-Commerce Menu Selections

4–8 E-Commerce User Guide

shipping cost, no matter how big the order; a Cost per Item  option, which assigns a
shipping cost to each item purchased; and a Percentage of Sales  option, which assigns
shipping cost based on the total dollar value of the sale.  You may only select one.

4. Specify the dollar (or percentage) cost associated with each shipping method.

• If you selected either Flat Rate or Cost per Item  methods, specify a dollar value price.

• If you selected the Percentage of Sales  method, specify a percent of sales amount.

5. When done, click OK.  If you do not wish to record your updates, click Cancel .
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Updating Products

You can update your Products  and ProductCategories  database by selecting the
E-Commerce > Products  menu options. The Fill Data  dialog box appears.  To learn more
about what is recorded in this dialog box, including how to import an existing database of your
own, and how your product category and product information is stored within your E-com-
merce database, see the chapter titled “WebShop Wizard—Building Your Database of Products
for Sale.”

The Fill Data  dialog box has two tabs: Products  and Product Categories .  To update your
products and product categories you will want to update the fields listed under each of these.

At the center of your WebStore are the products and product categories that you will use to
display your merchandise.  To help customers see those products that they want to see,
WebShop uses product categories to help them navigate through your database.  You will want
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to think carefully about how you set up your product categories and how you associate specific
products with the categories available.  You will also want to build your products database so
that all necessary product information is displayed.  Because this data may change frequently,
WebShop allows you to update this data at anytime, by accessing your database on the Web
server via a browser after generating the Web site (see the chapter titled “Database Administra-
tion by Merchant”).

To build the Product Categories database

1. Select the E-Commerce > Products  menu options. The Fill Data  dialog box appears.

2. Select the ProductCategories  tab.

3. Decide how you want to build your database.

• If you wish to import your data, see the procedure “Importing Product and Product
Categories Data” in the chapter titled WebShop Wizard—Building Your Database of
Products for Sale.

• If you wish to manually enter your data, go to the next step.

4. To add your first record, click + (plus sign) .  The Fill Data fields are now empty.

5.   Type the required product information.  To move between fields, click the field you want.

Note: The required fields are ID, Type and Description. The product categories that you build
must agree with the product categories that you assign when entering your products
database.

6 To add your next record, click + (plus sign) .

7. Repeat Steps 4–5 until all of your product data is entered.

8. Review your product data.

• To move forward or backward through your database one record at a time, use the
Forward  and Backward  navigation buttons at the top of the dialog box.

• To move to the start or the end of your database, use the Go to Start  or Go To End
navigation buttons at he top of the dialog box.

9. To delete a record that currently is displayed, click – (minus sign) .

Note:  Each E-commerce template comes with predefined example data. You will want to
delete the template’s example product category data and replace it with information about
your product categories.

10. When done recording your product category data, click Done  or click the Products  tab if
you want to build your Products  database.

To build the Products database

1.  Select the E-Commerce > Products  menu options. The Fill Data  dialog box appears.

2.  Select the Product  tab.
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3.  Decide how you want to build your database.

• If you wish to import your data, see the procedure “Importing Product and Product
Categories Data” in the chapter titled “WebShop Wizard—Building Your Database of
Products for Sale.”

• If you wish to manually enter your data, go to the next step.

4. To add your first record, click + (plus sign) . The Fill Data  fields are now empty.

5. Type the required product information. To move between fields, click the field you want.

• If you are entering a text field—there are 11 text fields in the Fill Data  dialog box
when the Products  tab is selected; two of these are combo boxes— type or select the
field value, as necessary.

• If you are entering the ProductImageURL , see the procedure “Loading Product Image
URL” later in this chapter.

6. To add your next record, click + (plus sign) .

7. Repeat Steps 4–5 until all of your product data is entered.

8. Review your product data.

• To move forward or backward through your database one record at a time, use the
Forward  and Backward  navigation buttons at the top of the dialog box.

• To move to the start or the end of your database, use the Go to Start  or Go to End
navigation buttons at the top of the dialog box.

9. To delete a record that currently is displayed, click – (minus sign) .

Note:  Each E-commerce template comes with pre-defined example data. You will want to
delete the template’s example product data and replace it with information about your
products for sale.

10 When done recording your product data, click Done  or click the ProductCategories  tab if
you want to build your ProductCategories  database.
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Introduction

There are several procedures associated with completing the WebShop Wizard.  One is per-
forming merchant registration.  Another is building your administrative database.  Last is
building your database of products for sale.  This chapter introduces those procedures associ-
ated with performing merchant registration.

Topics covered in this chapter include:

• WebShop Wizard and Merchant Registration

• Opening an E-commerce Template and Launching the WebShop Wizard

• Completing Merchant Registration

• What Happens Next?

WebShop Wizard and Merchant Registration

The WebShop Wizard is launched whenever you open any of the predefined WebShop tem-
plates.  This Wizard steps you through merchant registration and the creation of your Web site
databases.  The WebShop Wizard performs many of the procedures that otherwise would take
you long time to complete.  These include:

1. Performing Merchant Registration

2. Setting up Company Information

3. Specifying Payment Options

4. Specifying Shipping Methods

5. Setting Up Your Database of Products and Product Categories
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Opening an E-Commerce Template and Launching the
WebShop Wizard

When you first run WebShop, a default Web site is displayed in the Site Manager.  This default
site is used to create a standard Web site, not an E-commerce Web site.  To create an E-
commerce Web site, you must create a new project file based on one of the E-commerce
templates included with the WebShop program.

To start a new E-commerce project file and launch the WebShop Wizard

1. Select File > New  or click the New button from the Main toolbar.  The WebShop  Wizard
dialog box appears.

2. With this dialog box displayed, decide how you want to proceed.

• If you do not want to perform merchant registration and also do not want to set up your
database, click Cancel .  The WebShop Wizard has completed its processing.  The Site
Manager–Logical Layout  window opens for the Web site template you selected.  You
are ready to explore the template.

• If you want to enter data in your database, but do not want to perform merchant
registration, click I’ll Register Later .  The Wizard displays the Company  Information
dialog box appears.  Enter your company information (see the procedure “Entering
Company Information” later in this chapter).

• If you want to perform merchant registration and want to enter data in your database,
click Register Now  to continue.  The Merchant Registration dialog box appears (see
the procedure “Completing Merchant Registration” later in this chapter).
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Note: If you want to perform merchant registration after you have gone through the Wizard,
you can initiate Merchant Registration by selecting the E-Commerce > Merchant  Registra-
tion  menu options.  You cannot open the WebShop Wizard from a menu option.

Whenever you decide to go live with your WebStore, you must complete a merchant registra-
tion so you can transact business with your customers.  The registration process includes
registering as a merchant with a financial processing center, which verifies customer charges
and arranges for the deposit of funds into your account.  You can find out the set up cost
associated with opening your account by going to the Boomerang Software Web site
(www.boomerangsoftware.com).  Once your application is accepted a merchant account is
created with a commercial bank.

The start-up services required by the financial processing center include:

• Onetime Application for a New Merchant Account

• Onetime Set Up for Electronic Payment Processing

If your application is declined by the financial processing center, you will receive a complete
refund less a nominal processing fee of $15.

Completing Merchant Registration

You can decide to complete merchant registration either from within the WebShop Wizard or
from Site Manager by selecting E-Commerce > Merchant Registration  menu options.  In both
cases, WebShop takes you to the Merchant Registration dialog box.  From here, you must
confirm that you want to continue.  If you choose to continue, WebShop automatically launches
your preferred browser where you can complete merchant registration online.

To complete merchant registration

1. From the Merchant Registration  dialog box, decide how you want to proceed:

• If you want to continue the registration process, click Continue .  WebShop will launch
your system’s preferred browser and access the merchant registration Web site.

• If you do not want  to continue, click I’ll Register Later .  WebShop either will advance
to the Company Information  dialog box (if you are still in the Wizard) or return you to
the Site Manager–Logical Layout  window (if you are completing registration from
the E-commerce menu).
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2. With the Registration screen displayed, specify whether you already have a merchant
account and complete the required pre-registration information.

3. When done, click Continue .  Your browser will automatically access the next merchant
registration Web page.

4. Select the service options that you want.

Note: The default service options are Apply for a New Merchant Account and Set Up
Electronic Payment Processing.  The terms associated with each option are displayed.

5. When done, click Submit Registration .  You are prompted for merchant demographic
information.
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6. Complete the merchant demographic information.  Whatever data you entered earlier, on
the Registration  screen, defaults here.

7. When done, click Submit Registration .  You are prompted for payment information.

8. Complete the payment information fields.

Note: If you have questions about payment options, contact the financial processing center
directly.

9. When done, click Submit Payment Information .  The financial processing center displays
all registration information and calculates the total amount to be charged to your account.
If you need to change any of the information, press Back on your browser.
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10. Once everything is correct, click Submit Order .  You are now registered with the financial
processing center.  A confirmation message is displayed with your Store ID number and the
password that you supplied.

Note: You must write down your Store ID and password to complete the WebShop Wizard.
Record both of these values when entering the Company Information dialog box.  Also, to
obtain access to your administrative page, where you perform database administration
procedures, you must enter both of these values (see the chapters titled “Database Admin-
istration by Merchant” and “Maintaining Security and Bancing Up Your Files”).
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11. Decide how you want to proceed.

• If you started merchant registration from the Wizard, return to the WebShop program
so you can complete the Wizard and begin entering data.

• If you started registration from an existing Web site by using the E-commerce menu
options, return to the WebShop program so you can continue working from the Site
Manager window.

What Happens Next?

Using the Wizard is a three-step process.  You have just finished performing merchant registra-
tion.  You still need to build your administrative database and build your database of products
for sale.  In the next chapter, the procedures for building your administrative database will be
covered.
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Introduction

There are several procedures associated with completing the WebShop Wizard.  One is per-
forming merchant registration.  Another is building your administrative database.  Last is
building your database of products for sale.  This chapter introduces those procedures associ-
ated building your administrative database.

Topics covered in this chapter include:

• What Your Database Includes

• Setting Up Your Administrative Database

• Entering Company Information

• Specifying Payment Options

• Specifying Shipping Methods and Prices

• What Happens Next?

What Your Database Includes

Your database has several tables.  Some of this data is presented to your customer on one or
more Web pages.  Some is intended for internal use.  When you open an E-commerce template
and launch the Wizard, you are accessing example information that is already part of your
template.

Remember! Each E-commerce template comes with predefined example data.  The data
that you enter using the Wizard should help your customer learn more about your products,
terms of sale, and options that they can select.  You will want to delete or overwrite a
template’s example data so you can replace it with information about your company and
products.
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The tables that come with the E-commerce templates include the following:

••••• CompanyInfo .  This table is updated by you and stores information about your company.

••••• Payment_Methods .  This table is updated by you and stores information about the
payment methods you can accept.

••••• ProductCategories .  This table is updated by you and stores information about your
product categories.

••••• Products .  This table is updated by you and stores information about your products.

••••• Shipping_Methods .  This table is updated by you and stores information about your
available shipping methods.

••••• Shipping_Payment .  This table is updated by you and stores information about your
available shipping calculation method and prices.

The information contained in these tables is displayed to your customers through dynamic pages
(that is, predefined Web pages that dynamically interact with your database).  Merchants should
be aware that critical data associated with security is not displayed to customers and that all data
displayed to customers can be evaluated by you prior to publishing your Web site on the
Internet.

Setting Up Your Administrative Database

Your administrative database includes the following tables:

••••• CompanyInfo

••••• Payment_Methods

••••• Shipping_Methods

••••• Shipping_Payment

To build your administrative database you should normally use the Wizard.  The Wizard will
prompt you to enter the necessary information by displaying three dialog boxes for data entry.
When completed, each dialog box populates one or more of the above tables.  These dialog
boxes (in order of presentation) include:

1. Company Information

2. Select Payment Method

3. Shipping Methods and Prices

In addition to populating your data table through the Wizard, you can also update and change
your data using the E-Commerce  menu options.  You can access any of the above dialog boxes
through a separate menu selection.
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Entering Company Information

Use the Company Information  dialog box to enter data about you, the merchant company.
Here you can record company name, address, city, zip/postal enter, state/province and country.
You can also include a telephone number, fax number, and email address that your Internet
customers can use.  You can also enter the state sales tax rate or the country sales tax rate.  For
specific, tax treatment you should consult with your accountant or tax attorney.  Lastly, you
must specify a store ID number and password.  These are important fields.  Once you complete
Merchant Registration, you are assigned a store ID number.  As part of registration you are also
asked to provide a password that allows you to access your database.  You record each of these
fields here.  They are not displayed to your customers.  If you have not completed Merchant
Registration, leave the default Store ID in place; however, you should record a new password.

The rules for setting up a password are:

• Any alphanumeric string from four to eight characters long

• No spaces allowed

To enter company information

If you have finished Merchant Registration, close the browser and go back to WebShop.

1. With the Company Information  dialog box displayed, specify (or select from a drop-down
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list) the following field values, as necessary: Company Name , Address, City, Zip/Postal
Code, State/Province, Country, Phone Number, Fax Number,  and Email address.  To
select a field, click on it.  The existing data is highlighted.  To overwrite this information,
type the new information once the existing data highlighted.

2. Enter the Store ID  and Password  for your store.

• If you completed merchant registration, enter the Store ID that you were given during
the registration process and the password that you have assigned to your store.

• If you did not complete merchant registration, leave the default value (10002) for Store
ID and enter a password for your store.  You may use Store 10002 as a test WebStore

Note: Be sure to write this password down.  You will need it later when you complete
registration.

3. In the Sales Tax Rate  section, specify how you want WebShop to calculate sales taxes.

• If you want to calculate sales taxes for in-state customers only, click on the In State/
Province  radio button.

• If you want to calculate sales taxes for all customers no matter where they live, click
on the In Country  radio button.

Note: The general rule is that if you are selling products to a customer who is in the same
state as you (the merchant), then your state’s sales tax rate applies.  For this type of sales
tax calculation, select the “in state” option.  If you want to apply one sales tax rate to all
customers in the US, select the “in country” option.

4. In the Sales Tax Rate  section, specify the sales tax rate to apply in the Value  field.

5. When done, click Next .  The Select Payment Method  dialog box appears.

Specifying Payment Options

The Select Payment Method  dialog box lists the forms of payment that you can accept.  The
most common are Visa, MasterCard, American Express and Discover.  You can also accept a
virtual check; however, you must sign up for this service first.  Lastly, you can also select COD
(Cash on Delivery).  If you select this option, Internet customers will be automatically charged
$5.00 to cover the cost of processing a COD.

To specify your payment options

1. With the Select Payment Method  dialog box displayed, place a check mark next the
payment methods that you intend to offer.

• To place a check mark, click on the check box next to the payment option.

• To remove a check mark, click on the check mark next to the payment option.
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Note: The options you select must agree with the services that you purchased through your
financial processing center.

3.  When done, click Next .  The Shipping Methods and Prices  dialog box appears.

Specifying Shipping Methods and Prices

The Shipping Methods and Prices  dialog box lists the various shipping methods that you can
offer your Internet customers.  To complete this dialog box you must first determine what
methods you want to offer, how you want to calculate shipping costs, and the prices that you
want to apply.  WebShop currently offers the following shipping methods: Ground, Next Day,
2-day, Priority Mail, and International.  You may decide that some of these are not applicable to
your customers.  When you set your calculation method, two of them require a dollar price (the
flat rate method or cost per item method).  The last method, percentage of sales, requires that
you enter a percentage figure.  Currently, there is no calculation method that specifically takes
into account weight.  So you might want to be careful if you have products that vary greatly in
weight.
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To specify shipping methods and prices

1. With the Shipping Methods and Prices  dialog box displayed, place a check mark next the
shipping methods that you intend to offer.

• To place a check mark, click on the check box next to the shipping option.

• To remove a check mark, click on the check mark next to the shipping option.

2. Select the calculation method you intend to use when calculating shipping costs.

Note: There are three calculation options: a Flat Rate option, which assigns a flat rate
shipping cost, no matter how big the order; a Cost per Item option, which assigns a shipping
cost to each item purchased; and a Percentage of Sales option, which assigns shipping cost
based on the total dollar value of the sale.  You may only select one.

3. Enter the dollar or percentage cost associated with each shipping method.

• If you selected either Flat Rate or Cost per Item  methods, specify a dollar value price.

• If you selected the Percentage of Sales  method, specify a percent of sales amount.

4. When done, click Next .  The Fill Data  dialog box appears.

What Happens Next?

Using the Wizard is a three-step process.  You have just finished performing merchant registra-
tion and building your administrative database.  You still need to build your database of
products for sale.  This part of the process is covered in the next chapter.
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Introduction

There are several procedures associated with completing the WebShop Wizard.  One is per-
forming merchant registration.  Another is building your administrative database.  Last is
building your database of products for sale. This chapter introduces those procedures associated
with building your database of products for sale.

Topics covered in this chapter include:

• What is Your Database of Products for Sale?

• Building Your Product Categories Database

• Building Your Products Database

• Preparing Images for Use with WebShop

• What Happens Next?

What is Your Database of Products for Sale?

At the center of your WebStore are the products and product categories that you will use to
display your merchandise.  To help customers see those products that they want to see, Web-
Shop uses product categories to help them navigate through your database.  You will want to
think carefully about how you set up your product categories and how you associate specific
products with the categories available.  You will also want to build your products database so
that all necessary product information is displayed.  Because this data may change frequently,
WebShop allows you to update this data at anytime, by accessing your database on your server
after generating the Web site (see the chapter titled “Database Administration by Merchant”).

When initially building your database, however, you will want to construct your product
categories first.  Be aware that the template files have example data already recorded.  You will
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want to delete these example records.  It is recommended that you delete all but one record (to
have as an example) before recording your own data.  When done, be sure to delete that
example record as well.

Building Your Product Categories Database

At this point, you have completed merchant, and have built your administrative database.  You
are now starting the process of building your database of products for sale.  To accomplish this
there are two required steps building your ProductCategories database and building your
Products  database.
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After specifying your shipping methods and prices, the Wizard displays the Fill Data  dialog
box.  You can also obtain this dialog box by selecting the E-commerce > Products  menu
options.  This dialog box has two tabs: Products  and ProductCategories

When you build your ProductCategories  database it must be an all-inclusive set of categories,
every product you offer must be associated with one and only one product category.  To build
your ProductCategories  database, use the Fill Data  dialog box from within the WebShop
Wizard.

To build the product categories database

1. From the Fill Data  dialog box, click the ProductCategories  tab.

2. Decide how you want to build your database.

• If you wish to import your data, see the procedure “Importing Product and Product
Category Data” later in this chapter

• If you wish to manually enter your data, go to the next step.

3. To add first record, click + (plus sign) .  The Fill Data fields are now empty .

4. Type the required product category information.  To move between fields, click on the field
you want.

Note:  The required fields are: ID, Type, and Description.  The product categories that you
build must agree with the product categories that you assign when entering your products
database.

5. To add your next record, click + (plus sign) .

6. Repeat Steps 4–5 until all of your product category data is entered.

7. Review your product category data.

• To move forward or backward through your database one record at a time, use the
forward and backward navigation buttons at the top of the dialog box.

• To move to the start or the end of your database, use the Go to Start or Go to End
navigation buttons at the top of the dialog box.

8. To delete a record that currently is displayed, click – (minus sign) .

Note:  Each E-commerce template comes with pre-defined example data. You will want to
delete the template’s example product category data and replace it with information about
your product categories.

9. When done typing your product category data, click Done  or click the Products  tab if you
want to build your Products  database.  If you click Done , the WebShop Wizard has
completed its processing.  The Site Manager–Logical Layout  window for the E-commerce
template you selected is displayed.
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Building Your Products Database

When you build your Products  database, you will want to have your data prepared before
hand—particularly the graphics you will use to display your products.  These graphics are best
saved as .JPEG images.  When you go to enter a product image, you must double-click the
ProductImageURL  field.  This opens the Images  resource folder.  From there, you select the
image and click OK.  To load your product image URLs successfully, it is imperative that you
copy all of your product images to the Images  resource folder.   If you do not have a product
image to import, the image icon will read “Empty” and the product picture space (when viewed
online) will be blank.
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To build the products database

1. From the Fill Data  dialog box, click the Products  tab.

2. Decide how you want to build your database.

• If you wish to import your data, see the procedure “Importing Product and Product
Category Data” later in this chapter

• If you wish to manually enter your data, go to the next step.

3. To add first record, click + (plus sign) .  The Fill Data fields are now empty.

4. Type the required product information.  To move between fields, click on the field you
want.

• If you are entering a text field—there are 11 text fields in the Fill Data  dialog box
when the Products  tab is selected—type of the field value, as necessary.

• If you are entering the ProductImageURL , see the procedure “Loading Product Image
URL” later in this chapter.

5. To add your next record, click + (plus sign) .

6. Repeat Steps 4–5 until all of your product data is entered.

7. Review your product data.

• To move forward or backward through your database one record at a time, use the
Forward  and Backward  navigation buttons at the top of the dialog box.

• To move to the start or the end of your database, use the Go to Start  or Go to End
navigation buttons at the top of the dialog box.

8. To delete a record that currently is displayed, click – (minus sign) .

Note:  Each E-commerce template comes with predefined example data. You will want to
delete the template’s example product data and replace it with information about your
products for sale.
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9. When done typing your product category data, click Done  or click the Products  tab if you
want to build your Products  database.  If you click Done , the WebShop Wizard has
completed its processing.  The Site Manager–Logical Layout  window for the E-commerce
template you selected is displayed.

Loading A Product Image URL

To load a product image URL into your product data base, you will need to first have the
product image available either on your hard drive, in your project’s image folder, in one of the
WebShop’s Libraries, or have a specific Internet URL address to use.  To load the image, use
the Choose Resource  dialog box.

To load an image that is already in the project image folder

1. From the Fill Data  dialog box, double-click the currently existing image or on the image
icon that reads “Empty.”   The Choose Resource  dialog box appears.

2. Open the Images  folder.

3. Select the image that you want by clicking on it.  A preview image is displayed.

4. To load the image URL, click OK.  The Data Fill  dialog box reappears with the image that
you selected displayed.

To load an image that is on your hard drive

1. From the Fill Data  dialog box, double-click the currently existing image or on the image
icon that reads “Empty.” The Choose Resource  dialog box appears.

2. Click Import .

3. Navigate to where the image is stored.

4. Select the image that you want.  If the preview box is checked, a preview image appears.

5. Click OK to load the image into the project image folder. A preview image is displayed.

6. To load the image URL, click OK. The Data Fill  dialog box reappears with the image that
you selected displayed.

To load an image that is in the Library

1. From the Fill Data  dialog box, double-click the currently existing image or on the image
icon that reads “Empty.” The Choose Resource  dialog box appears.

2. Click the Library tab and select the library you want from the drop-down list.  Small
thumbnail previews are displayed.

3. Click the Insert button to load the image into the project image folder. A preview image is
displayed.

4. To load the image URL, click OK. The Data Fill  dialog box reappears with the image that
you selected displayed.
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To load an image that is on the Internet

1. From the Fill Data  dialog box, double-click the currently existing image or on the image
icon that reads “Empty.”  The Choose Resource  dialog box appears.

2. Click the URL tab and enter the exact URL address for the image that you want.

3. Click Insert  to load the image into the project image folder. A preview image is displayed.

4. To load the image URL, click OK. The Data Fill  dialog box reappears with the image that
you selected displayed.

Importing Product and Product Category Data

If you currently have products or product categories data stored in a Microsoft Access database
(or one that can either be imported into Microsoft access or converted into an MDB format),
you must first verify that your database has data tables labeled Products  or ProductCatego-
ries .  For each database table, be sure that the following field names are used in the following
sequence:

••••• ProductCategories —ID, Type, Description

••••• Products —ProductID, ProductEnter, Notes, ProductIntroductionDate,  ProductName,
ProductDescription, ProductSize, ProductImageURL, UnitPrice,  OnSale, TypeID,
UnitWeight

Be mindful of the following:

• If some field values are missing, they are initialized by default (that is, WebShop will
automatically code these fields with a zero or a blank).  You will have to edit that data after
the database is imported.

• If your database contains additional tables and/or additional fields,  you can still import the
file. The additional databases and fields are simply ignored.

Note:  If you are using the import function to import a database, make sure that the tables
contained in your *.MDB database have the exact field names in the exact order required.
Additional fields must be placed after the required field sequence, if the import feature is to
work.

• When entering ProductImageURL , you must enter the file name and relative path for the
image that you want to display. You must also have the image files available in the Image
folder.  When the Web site is generated the database calls up the correct image by linking it
to the graphic resource.  The product database does not physically store your product.
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To import your product data from an existing database

1. Convert (if needed) your database file to an *.MDB file and reorganize its content to match
the field sequence described above.

2. Verify that the Fill Data  dialog box is open.

3. Click Import From .  The Open  dialog box appears.

4. Navigate to the *.MDB file that you want to use.  Note that the Type of File  is predefined
to accept an  Access Database (* .MDB) only.

5. Select the file you want and click Open or double-click the file name from the directory.

6. The Wizard automatically populates your database with the data from your *..MDB file.
Verify that the data was correctly imported by scrolling through your data

Note:  If you have trouble, verify that the file you selected was a database file (with exten-
sion *.MDB) and that the data was in the required sequence.

7. When you have completed recording your product data, click Done .  The WebShop Wizard
has completed its processing. The Site Manager–Logical Layout  window for the E-
commerce template you selected is displayed.
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Preparing Images for Use with WebShop

Keep in mind that WebShop uses GIF and JPEG formats for storing images, so when you go to
create images you will want to save them in one of those formats.  Also, keep in mind these
basic ideas:

••••• Image resolution .  The higher the image resolution, the larger the image file—and the
larger the image file, the longer it takes to download.  For Internet display, image resolu-
tions of 76 – 10 dpi (dots per inch) is sufficient for either GIF or JPEG images.

••••• Image size .  The larger the image the larger the image file.  You will want to keep your
images small whenever possible—especially for JPEG images.

••••• Image colors .  GIF images can be stored at four different color settings 2, 8, 16, and 256.
By limiting the number of colors used, the image files are kept smaller.  JPEG images are
formatted in TrueColor, which allows for a color palette in excess of 16 million.  You
should use the JPEG format when color gradation is important, such as with photographs.

••••• Image compressions .  WebShop classifies images as Vector or Raster images. Vector
images use the GIF format, which allows for greater compression.  Raster images use the
JPEG format, which allows for less compression.  JPEG images are higher quality images
because information is stored pixel by pixel. Whenever creating JPEG images in a separate
application such as MGI PhotoSuite, save your images at 75% resolution with a 24 bits per
pixel.  This is the default setting for JPEG formatted images.

When creating your product images you will want them all to be the same size.  You will
greatly improve your product “look” if there is a consistency image size throughout.
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Introduction

Suppose customers have been buying from your WebStore and you now want to introduce a
new product.  How are you going to do it? All of your product data was uploaded to your Web-
hosting service or Internet Service Provider (ISP).  You need direct access to the product
database from your local computer—because you are no longer in development—you’re in
production! Sounds like a difficult situation, doesn’t it? That’s when WebShop’s database
administration feature is going to be used—making changes to your production database after
going “live.” Going “live” means that you have designed your E-commerce site, completed the
initial entry of your administrative and product data, uploaded the site to your Web-server and
are now setup as an electronic merchant who is taking orders over the Internet.

Note: If your WebShop files are not on a Web-hosting service but are hosted on your own
intra-company server, you may still need to log on or access that server through your
browser.  Refer to your system administrator for help.

To access your database, you must go online and clear two levels of security: first-level Web-
server security and a second-level WebShop administration security.

You visit your WebStore by browser and using your Web-server password (first-level security)
and your assigned store ID and password (second-level security), you access your remote Web-
server database using your installed WebStore administration page.  Now, you can make
whatever changes you need.  To make your changes, however, you must work through a
number of different administrative forms generated by your WebStore.  That is what we are
going to cover in this chapter.

Note: The Database Administration feature of WebShop is a very useful tool that lets you
make additions, changes and deletions to your remote Web-server database.  These may
include updating prices quickly, removing items, and so on.  However, at some point you
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may want to replace the entire Products database of your WebStore by overwriting the
existing database on your remote Web-server.

Topics covered in this chapter include:

• Your Web Site’s Administration Interface

• What is Your E-Commerce Database?

• Administrative Procedures

• Other Maintenance Procedures

Your Web Site’s Administration Interface

Your E-commerce Web site has an administration page that you may access through a hyperlink
on your StoreFront.  This is your doorway into your database.  This administration page has the
physical name Admin.htm, and is stored in the WebStore folder within the Administration
subfolder.  For example, the URL for this page is www.<web host>/<user name>/webstore /
administration/admin.htm.  This page is designed as a frame page.  The bottom half contains
links to each of the various forms that you use to make your database changes.  The bottom half
displays them.  The top half contains a Home button to return you to the Home Page of your
Web site.
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To access your administration page through a browser

1. Open your local browser and access your WebStore using the appropriate URL.  For
example, the URL for this page is www.<web host>/<user name>/webstore /administra-
tion/admin.htm.

2. If you are not already at the StoreFront when you get to your Web site, click the link that
takes you to the StoreFront.  (This would only happen if you added a New Home Page
logically above the StoreFront.)

3. Click the text or graphic link labeled My Own Business .  This is the default text.  You can
change this if your want.

4. If your administration folder is password protected, first-level Web-server security gener-
ates a dialog box that requests your Web-server password.  Enter your Web-server pass-
word and click OK.

5. Before accessing the Administration Page, second-level WebShop Administration security
displays a security form that requests your store ID and password.  Enter the required
values and click Submit .  The Administration page appears.  You can now begin making
changes to your remote Web-server database.

Note: The E-commerce templates each have a page titled “readme.htm” which further
explains access to Admin.htm.

What is Your E-Commerce Database?

Your database file is vital to the success of your WebStore.  The administrative procedures
covered in this chapter will help you keep all various pieces of your database up to date.
However, you should be aware that only some of the tables in your remote Web-server database
are truly dynamic—for example, your Customers table and your Orders table.  Your customers
update these tables using the dynamic pages that make your WebStore work.  By placing an
order, your customers are, through the associated dynamic pages, creating a Customer record
and an Order record that you can access through the Administration Interface.  Other tables do
not get updated by your customers—for example, your ProductCategories  table and Products
table.  Only you can update these tables.  Lastly, some of your database tables are static (that is,
unchanging)—for example, the Countries table and the States table.  WebShop automatically
creates these tables when you generate your E-commerce Web site.  The States table is just a list
of the 50 United States.  The Countries table is just a list of the world’s various countries.  Both
of these tables do not require administration.

The tables contained on your remote *.MDB database file, in alphabetical order, are as follows:

••••• Basket .  E-commerce functionality updates this table automatically when a visitor fills his/
her shopping cart with items.  It stores Visitor ID,  Product ID,  and Quantity .

••••• CompanyInfo .  You update this table as necessary.  It stores basic information about your
company.
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••••• Countries .  This table is a static table and should not be updated.  It stores the names of the
world’s various countries.

••••• Customers .  E-commerce functionality updates this table automatically when a customer
enters your WebStore and completes registration.  Customers are prompted to update this
information whenever they place an order.  It stores basic customer information such as
customer name, address, telephone number, and email address.

••••• Order_Details .  E-commerce functionality updates this table automatically when your
customers submit an order and a purchase transaction takes place.  It stores order detail
such as product ID, quantity and unit price.

••••• Orders .  E-commerce functionality updates this table automatically when your customers
submit an order and a purchase transaction takes place.  It stores basic order information
such as customer name, shipping address, and shipping method.

••••• Payment_Methods .  You update this table as necessary.  It stores information about the
payment methods that you accept as well as the other available methods.

••••• ProductCategories .  You update this table as necessary.  It stores information about the
product categories that you have established.

••••• Products .  You update this table as necessary.  It stores information about your products
such as product ID and unit price.

••••• Shipping_Methods .  You update this table as necessary.  It stores information about the
shipping methods that you accept.
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••••• Shipping_Payment .  You update this table as necessary.  It stores information about the
calculation method that you selected as well as the other available methods.

••••• States .  This table is a static table and should not be updated.  It stores the names of the 50
United States.

••••• Visitors .  E-commerce functionality updates this table automatically whenever a customer
enters your WebStore.  It stores a computer ID that serves as a Visitor ID.  This Visitor ID
enables your customer to interact with E-commerce functionality.  If your WebStore cannot
issue a Visitor ID because a customer’s browser is not configured to accept cookies, then
this table is not updated.  You should download a copy of this file routinely.

Note: All of the data contained in your remote Web-server database can be downloaded and
viewed through Microsoft Access.  If you choose to make changes to your database locally
(that is, on your PC) be very careful about the changes you make.  There are links between
the tables.  With improper handling, these can be corrupted—if you remove or change data
fields.

Remember!   Ask your Web-hosting company place access restrictions on your Database
folder.  See the chapter titled “Maintaining Security and Backing up Your Files.”

Making Changes to Your Database

You should be aware that making changes to your database requires careful consideration.

••••• Continuous shopping .  If you make changes by downloading your database, or by using
the Database Administration feature online during normal business hours, customers may
continue shopping.  That means that from the time you download your database (or start
making changes online) to the time you upload your database again (or finish making
changes online) new records may be added by shoppers that potentially could be corrupted.

••••• Example .  Suppose a shopper puts a product ABC into his/her shopping cart and continues
shopping.  Meanwhile you come online and delete product ABC.  The next time he/she
goes to his/her shopping cart, a ABC product will no longer exist.  Or worse, if you delete
product ABC while your customer is completing order entry, they will receive error
messages that will prevent them from completing the transaction.

••••• Solution .  Close your WebStore while making your changes.  WebShop comes with a
feature that allows you to close your WebStore while you make your changes.  The
Administration Page has a command button that allows you to “Lock” the store prior to
making changes.  Customers who are in the store at the time that you lock it will receive a
message that they no longer have access to the site.  For the period that the store is closed,
WebShop resets the site permissions to include only authorized users.  This effectively
closes the store.  If you choose, you can close your WebStore for an extended period while
you make your database changes locally on your personal computer.  You will be losing
sales though.  That’s why it is recommended that you make your database changes during a
low volume period.
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Note: When done making your changes either online or locally, be sure to open your
WebStore! The Administration Switchboard page contains the Lock and Unlock links that
allow you to open and close your WebStore.

Administrative Procedures

The administrative procedures covered in this section are based on WebShop’s Database
Administration feature, which uses a dynamic Administration page to complete each procedure.
This dynamic page is stored in the Administration folder under the WebShop folder.  To access
this dynamic page online (once you generate and upload your completed Web site) you must go
through two levels of security.  If your Administration folder is password protected, there is a
first-level Web-server security.  After Web-server security is complete, there is a second-level
WebShop administration security.  Once the Administration page appears, several navigation
buttons link you to the required forms.  These forms enable you to complete your database
updates.

Editing Company Information

The CompanyInfo  table on your database file (with extension *.MDB) is where company name,
address, city, zip/postal enter, state/province and country are recorded.  There are also fields for
telephone number, fax number, and email address.  Your Internet customers view this informa-
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tion using the Company Information page.  The TaxType  and the TaxRate  values are also
recorded on the CompanyInfo table.  TaxType  is the tax assessment method (that is, either in-
state or in-country).  TaxRate  is the assessment rate used when calculating tax amounts.

Note: For applicable tax advice, consult your accountant or tax attorney.

To edit company information from the Administration Page

1. Click the Update Company Information  navigation bar, or click the Update Company
Info  text link.  Company Information  form appears.

2. Click any field that you want to change.

3. Type over the existing field value.  Repeat for every field that you want to change.

4. When done, click Update Company Info .

Editing Product Categories and Products

When editing your product categories and products database, you must keep in mind how these
two databases are related.  When you initially set up your product categories, every product you
wanted to offer through your WebStore had to be associated with one and only one product
category.  That’s how your customers get access to product details! In a similar fashion, when
you go to edit your product categories and products, you start first with the product categories.
Here, you make whatever product categories additions, changes, or deletions you need.  Next,
you then access the various products for a specific category by clicking Go to Products .  Now,
you can make individual product additions, changes or deletions.

Note: If you delete a product category you, simultaneously, will be deleting all of the
products associated with that category.  Unless you know for certain that you want to do
this, the recommended approach is to individually delete products from a category first and
then delete the product category.  Also, be aware that you should not reassign a product
from one category to another using the Administration page forms.  You can delete and re-
add, but if you simply want to reassign a product, you should add it to one category then
delete it from the other category.

When updating your product database, you may want to change one or more product images or
add an new product image for a newly introduced item.  Product images are not physically
stored in your database.  They are physically stored in the image folder of your Web site.  To
change a product image, you must first enter the file name and relative path for the image that
you want to display.  Then, you must then make that image physically available by uploading
the image (through FTP) to the image folder on your server.  For example, if your image file is
called “Tiger.jpg,” the image URL will be Images/Tiger.jpg.
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To make any change, addition or deletion to the product or product categories
table from the Administration Page

• Click the Categories and Products  navigation bar, or click the Edit Categories and
Products  text link.  The Product Categories  form appears.  All of your current product
categories are listed on the bottom half of this form.

To add a product category

1. In the Add New Product Type  section, click Name field and type a category name.

2. Click Description  field and type over the default text.

3. When done, click Add .  The new product category displays at the bottom of the category
listing.

To change a product category

1. In product category listing at the bottom of the Product Categories  form, locate the
product category that you want to change.

2. Decide what you want to do:

• To change the category name, click the Name field and type over the current value.

• To change the category description, click the Description  field and type over the
current value.
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3. When done, click Change .  The new product category name defaults to every product
currently entered for that category.

Note: Category Description is not displayed to your customers.  This field is used for internal
purposes.

To delete a product category

1. In the product category listing at the bottom of the Product Categories form, locate the
product category that you want to delete.

2. Click Delete .  The product category disappears from the category listing and any products
currently associated with that product category are deleted.

To view the products currently associated with a product category

1. From the Product Categories  form, locate the product category that contains the products
you want to view.

2. Click Go to Products  for that category.  The product category form disappears and is
replaced with the Products  form.  The product category name appears in the heading.  All
of the products currently associated with that product category are listed in the lower half
of the form.
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Note: If the category contains many products, you may need to scroll down the list to see
them all.

3. To return to Product Categories , click your browser’s Back button, or the Back to
Categories  text link.

To add a new product to a product category

1. In product category listing at the bottom, locate the product category that is to receive the
new product.

2. Click Go to Products  for that category.  The Product Category  form disappears and is
replaced with the Products  form.

3. In the Add New Product  section, click the first field and type the necessary data.  Repeat
this for every field you want to enter.

Note: When entering ProductImageURL, you must enter the file name and relative path for
the image that you want to display.  You must also have the image files available in the
Image Folder of your Web site if the image is to display.  See the procedure on uploading a
new product image.

4. When done, click Add New Product .  The new product displays at the bottom of the
product listing.

5. To return to Product Categories , click your browser’s Back button, or the Back to
Categories  text link.

To edit an existing product

1. In product listing at the bottom of the Products  form, locate the product that you want to
edit.

2. Click the first field that you want to edit and type over the current value with the necessary
data.  Repeat this for every field you want to change.

Note: When changing a product image by assigning a new ProductImageURL, you must
enter the file name and relative path for the image that you want to display.  You must also
have the image files available in your Web site’s Image Folder if the image is to display.  See
the procedure on uploading a new product image.

3. When done, click the Update  button.  The new product data is now recorded.

4. To return to Product Categories , click your browser’s Back  button, or the Back to
Categories  text link.

To delete a product

1. In product listing at the bottom of the Products  form, locate the product that you want to
delete.

2. Click Delete .  The product disappears from the listing and any products currently associ-
ated with that product category are deleted.
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Note: You now have an orphaned image resource in the Image Folder of your Web site.  This
will not cause any performance problems, but it is recommended that you do not build up a
large number of orphaned product images.

Editing Shipping Methods

The Shipping_Methods  table on your database file (with extension *.MDB) is where each of
your shipping methods is specified.  It is also where you specify the calculation method used to
determine shipping costs.  Each calculation method requires either a dollar price or percent of
sales amount.  Keep in mind that whichever calculation method you select, it must apply to all
of your specified shipping methods.  You should not select a unique calculation method for
individual shipping methods.

To edit your Shipping Methods table from the Administration page

• Click the Shipping Methods  navigation bar, or click the Edit Shipping Methods  text link.
The Shipping Methods form appears.  All of your currently entered shipping methods are
listed on the bottom half of this form.

To change your shipping method specifications

1. Place a check mark under to column labeled Supported  for each shipping method that you
intend to offer.

• To place a check mark, click on the check box.

• To remove a check mark, click on the check mark.

2. When done, click Update for each method changed.

3. Select the calculation method you intend to use when calculating shipping costs from the
drop down list.

Note: There are three calculation options: a Flat Rate option, which assigns a flat rate
shipping cost, no matter how big the order; a Cost per Item option, which assigns a shipping
cost to each item purchased; and a Percentage of Sales option, which assigns shipping cost
based on the total dollar value of the sale.  You may only select one.

4. When done, click Update Shipping Calculation Method .

5. Enter the dollar or percentage cost associated with each shipping method that you intend to
offer.

• If you selected either Flat Rate or Cost per Item  methods, specify a dollar value price.

• If you selected the Percentage of Sales  method, specify a percent of sales amount.

6. When done, click Update for each method changed.
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Editing Payment Methods

The Payment_Methods  table on your database file (with extension *.MDB) is where your
payment methods are specified.  When you completed the Wizard, you made your payment
selection based on six payment options: Visa, MasterCard, American Express, Discover, Virtual
Check, and COD (Cash On Delivery).  You can update your selections using the Payment
Methods form accessed through the Administration page.

To edit your Payment Methods table from the Administration page

• Click the Payment Methods  navigation bar, or click the Edit Payment Methods  text link.
The Payment Methods  form appears.  All of your currently entered Payment Methods are
displayed.

To change your payment method specifications

1. Place a check mark under the column labeled Supported  for each payment methods that
you intend to offer.

• To place a check mark, click on the check box.

• To remove a check mark, click on the check mark.
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Note: The options you select must agree with the services that you purchased through your
financial processing center.

2. When done, click Apply  Changes .

To make a payment name changes or to reclassify a payment method as a credit
card method

1. Locate the payment method that you want to change.

2. Decide what you want to do:

• To change the method name, click Name field and type over the current value.

• To reclassify the payment method, select or deselect the Credit Card  check box.  Click
the check box once.  If is a check mark is present, the payment method is classified as
a credit card method.  If no check mark is present, the payment method is not classified
as a credit card method.

3. When done, click Change .  The new method specifications are saved.

Viewing Customers and Orders

To view customers and orders you must access three different tables: Customers, Orders , and
Order_Details .  To access and view this information, you first access the View  Customers
form.  This lists all of your customer records.  To view a specific customer’s various orders, you
must locate that customer and Click the View Orders  icon.  This generates a listing of orders for
that customer.  To locate specific order details for one of this customer’s orders, you must locate
the specific order and click the View Details  icon.  Both the View Orders  icon and the View
Details icon lead you down through the data hierarchy.

The Customers table on your database file (with extension *.MDB) is updated whenever a
customer registers with your WebStore.

The Orders  and Order_Details  tables on your database file (with extension *.MDB) are
updated only when a buy transaction is complete and email confirmations are sent.

To view customers, orders, and order details from the Administration Page

• Click Customers and Orders  or click the View Customers and Orders  text link.  The
View Customer form appears.  All of your currently captured customer information
appears.

To view a specific customer’s orders

1. From the customer listing, locate the customer whose orders you want to view.

2. Click the View Orders icon for that customer.  The View Orders  form appears.  All of the
orders for that customer are displayed.

To view order details for a specific order

1. From the order listing, locate the specific order that you want to view in detail.
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2. Click the View Details  icon for that order.  The View Details  form appears.  The order
details for just that one order are displayed.

To delete a specific order and its associated order details

1. From the customer listing, locate the specific customer whose order you want to delete.

2. Click the View Orders  icon for that customer.  The View Orders  form appears.  All of the
orders for that customer are displayed.

3. From the order listing, locate the specific order that you want to delete.

4. Click the Delete  icon for that order.  This action simultaneously deletes both the Order
record and the associated Order Detail record.

Other Maintenance Procedures

There are other maintenance procedures of which you should be aware.  Suppose you want to
make a change to a Web page, a change that does not impact your database.  How do you do
that? Or, if all your graphic images stored as resources in the Images file, what happens if you
add a new product and want to update the image folder on your server with the new product’s
image?

Keeping a Safe Backup of Your Web Site Database

When you complete development, just prior to generating your Web site, you can review the
data you have recorded in your database prior to going live.  Once you make changes to your
database after going live, your records will not agree.  An important part of maintaining a safe
backup is to make all of your database changes to your *.CNQ file backup, or to regularly
download your database to your local PC and save it separately.  Both of these procedures are
covered in the chapter titled “ Working with Your ISP and Uploading Your Site.”

Note: Some data tables are created during site generation.  If you look at your database
prior to generating your Web site, you will find that your ShopDB.mdb file does not contain
all of the tables that are available after site generation.

All of the data contained in your remote Web-server database can be downloaded and
viewed through Microsoft Access.  If you choose to make changes to your database locally
(that is, on your PC) be very careful about the changes you make.  There are links between
the tables.  With improper handling, these can be corrupted—if you remove or change data
fields.  As a rule, do not make any changes to the following tables:

Also, remember to have your Web-hosting company place access restrictions on your
Database folder.  See the chapter titled “Maintaining Security and Backing up Your Files.”

Prior to site generation, the database contained on your ShopDB.mdb file is considered a virtual
database, that is, it is a database not stored in final format.  This allows you easy access during
development.  Once the site is generated, it is stored in final format and is then ready for upload.



E-Commerce User Guide 8–15

Chapter 8.  Database Administration by Merchant

The tables contained on your ShopDB.mdb file prior to site generation are:

••••• CompanyInfo

••••• Products

••••• ProductCategories

••••• Payment_Methods

••••• Shipping_Methods

••••• Shipping_Payment

To view or update your virtual database prior to generating your Web site

1. Double-click the Database folder from Site Manager Physical Layout .

2. Double-click the ShopDB .mdb  file icon.  The Fill Data  dialog box appears.

3. Click the tab for the data table that you want to view or update.  (There are eight tabs.)

4. Decide what you want to do:

• To move forward or backward through your database one record at a time, use the
Forward  and Backward  navigation buttons at the top of the dialog box.  If there is
only one record these buttons are grayed out

• To move to the start or the end of your database, use the Go to Start  or Go to End
navigation buttons at the top of the dialog box.  If there is only one record these
buttons are grayed out

• To add or delete a record, click + (plus sign)  or the – (minus sign) .

• To change a field value, click the field that you want to change.

5. When done, click Done .



Chapter 9.
Working with Your ISP and
Uploading Your Site

Introduction

When you’re ready to begin developing your E-commerce Web site, you must arrange for
hosting services before you begin testing out your E-commerce site.  Unlike a standard Web
site, you must generate and upload your E-commerce site to an NT-server that is 100% compat-
ible with Active Serve Page (ASP) technology before you can view and test your E-commerce
Web pages with a browser.  Because your E-commerce Web pages make use of ASP technol-
ogy, to function properly, they must access and update the database that stores your products
and customer orders.  Most PC systems do not have this capability—however, an NT-server that
is 100% compatible with ASP technology does.  To understand this, you must know what a
hosting service does and what kinds of system requirements are necessary to successfully host
your E-commerce Web site.

Topics covered in this chapter include:

• Selecting an ISP or Web-Hosting Service

• Hosting Requirements

• Active-X Component Registration

• Boomerang Software as a Web-Host Provider

• What is Your Integrated CNQ Project File?

• Saving Your Files in CNQ Format

• Generating and Uploading Your Web Site

• Uploading a Revised Site

• Uploading Selected Files
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Selecting an ISP and a Web-Hosting Service

To arrange hosting services, you will need access to an Internet Service Provider (ISP) or a
Web-hosting service provider.  These two providers are not the same.  However, while most
ISPs do offer Web-hosting services, most Web-hosting providers do not specialize in Internet
access accounts.

What is an ISP?
An ISP is a provider who connects you to the Internet.  They offer services such as email, dial-
up or direct access, and, of course the capability to surf the Web.  With an ISP, you gain full
access to the World Wide Web.  Normally, this means that you set up an account and make a
connection between your PC and the ISP’s server.  With this connection, you can surf the Web.
To make this connection, most people use a modem.  This is using a Dial-up Account.  How-
ever, if you want to get fancy, you could have a dedicated line that connects your PC to an ISP-
server.  Some people use MediaOne, a direct access provider.  What is important here is, not
that you have one or the other kind of networking, but that you know how you are going to
establish your connection with your ISP—by a modem or though a dedicated line.

What is a Web-hosting Service Provider?
A Web-hosting service provider, also known as a Web-hosting company, is company that hosts
Web sites on the Internet for others.  Their only customers are those who want to put a Web site
on the World Wide Web.  They are not looking to give Internet access to individuals.  That’s the
job of an ISP! They are only looking to provide hosting services to individuals (or companies)
who want to “publish” a site on the Internet.

Selecting an ISP
If you currently are a customer of America Online (AOL), you have already selected an ISP;
however, you should know that you might not be able to use them as a Web-hosting service.  E-
commerce Web sites have specific hosting requirements (such as, the 100% compatible with
ASP technology requirement for one) that AOL may not be able to satisfy.  However, AOL
does provide 2 Mb.  of free Web space to its customers.  So, if you intend to put up a standard
Web site, you might want to consider using your AOL account.  If you are not  a customer of
America Online, then you must find an ISP that gives you the features that you want.  Typical
features to look for in an ISP include monthly cost, email service, connection method, and
speed of transmission.

Selecting a Web-hosting Service
There are many factors that influence your selection of a Web-hosting service, not the least
among them are the specific requirements for hosting an E-commerce Web site (see the topic
“Hosting Requirements” later in this chapter).

Before looking for a Web-hosting service, you will want to decide whether you want a full
domain Web site or a sub domain Web site.  A full domain Web site is a uniquely identified
Web site using a licensed URL (for example, www.yourname.com).  A sub-domain Web site is a
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uniquely identified Web site that leases space under a preexisting URL (for example,
www.ISPdomainname.com/your name).  When making the full- or sub-domain decision, you
will want to consider how you intend to advertise your Web site.  Most companies seek to have
a full-domain Web site since it more specifically advertises their company.  If you do choose to
go with a sub-domain Web site, you will in effect be advertising someone else’s Web site and
directing them to use a specific subfolder under that domain name.  There are some clear cost
advantages, but it really comes down to the issue of marketing.

If you choose to setup a full-domain Web site, you will need to choose and register your full
domain URL before uploading your Web-site to a hosting service.  To search for and verify the
availability of a domain name you like, use InterNIC Registration Services (www.internic.net).
Its part of Network Solutions, a provider of domain name registration services.  The cost for
registering a domain name is $70 for two years with a $35 charge for each additional year after
the first two.  Many hosting services will, for a fee, help you register your domain name.  If you
choose to go the sub-domain route, you will be using your hosting service’s URL domain.  In
such cases, there normally is no setup fee.

To better evaluate your Web-hosting service, you should be concerned with a number of
generic factors not specific to your E-commerce Web site.  These include:

••••• Method of access .  You will access your Web site via the World Wide Web using a
browser or via an FTP application.  If your Web-hosting service is not your ISP, you will
be limited by your ISP mode of access not your Web-hosting service mode of access.
Web-hosting companies usually run on faster lines than ISPs.

••••• Download transfer .  Normally stated as megabytes (or gigabytes) per month which,
roughly translated, is a measure of total pages downloaded per month by Internet users (or
you can think of it as total number of hits per month).  If you anticipate a high rate of
usage, some companies will tack on an additional charge for usage that exceeds the
standard offer.  Some sites offer unlimited download transfer, but you will want to verify
exactly what that means before signing up.

••••• Storage space offered .  Normally, storage is offered as so many megabytes (or gigabytes)
per site for a flat rate.  This is one of the major variables in selecting a Web-hosting service.
If you anticipate a large number of graphics or a large database, then you will need more
storage space.  Without embellishment an E-commerce site with a modest product database,
currently requires 3–5 megabytes of storage.  An average amount of storage space offered
for a flat rate is currently between 5–20 megabytes.  Over time, your database will begin to
accumulate data, so you don’t want to max out too quickly.

••••• FTP capability .  It may sound obvious but you have to send files over the Internet via FTP.
Any Web-hosting service that does not offer this should not be used.

••••• Tech support .  You will want to ask about tech support.  Normally you will not need much
tech support, but when you do it is a great thing to have.  Tech support concerns issues such
as Internet access failures (customers cannot call up your site); FTP failures (specific
images or pages not being displayed), file retention and back procedures, Web site installa-
tion (including security).  A good service should offer tech support in these areas.
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••••• Domain name registration .  If you want to have a full domain Web site and also want help
registering it, many Web-hosting companies offer registration services to assist you.  You
can do this on your own, but it’s often nice to get a little help along the way.

••••• Initial setup fees .  Most companies will assess an initial set up fee.  Depending upon the
provider this may or may not apply to sub-domain Web sites.

Hosting Requirements

An E-commerce Web site has some very specific requirements that you must be aware of when
looking for a Web-hosting service provider.  These requirements are summarized below.

••••• NT-server that is 100% compatible with ASP technology .  To run an E-commerce site
created by this program, your hosting service must run an NT-server that is 100% compat-
ible with ASP technology.  This requirement is normally met by an NT-server that has
Microsoft Internet Information Server (version 3.0 or higher) installed.  Microsoft Internet
Information Server (IIS) is a Web site management program and is capable of interpreting
Active Server Pages (ASPs).  These pages are critical to your E-commerce Web site.  This
program manages your site properties and folder security.  For Windows ’95 users an
alternative Web site management program would be Peer Web Server.

••••• Active-X Component Registration .  WebShop’s E-commerce functionality right now
makes use of Active-X component technology for sending email.  The Active-X compo-
nent is a program developed by Boomerang Software that resides not in your HTML files
but on your Web-hosting company’s NT-server.  The Active-X component is a *.DLL file
that must be registered on your Web-hosting company’s NT-directory of Active-X compo-
nents.  For successful hosting of your site, you need to request that your Web site / ISP
provider register the Active-X component on the NT-server that is hosting your site.

••••• Site Security and Folder Security .  You will want to insure security over your E-com-
merce Web site.  That means your Web site administrator will have to place access restric-
tions on your entire Web site during development and more specifically on your Adminis-
tration folder and Database folder once you decide to go live.  Make sure you select a Web-
hosting provider that will correctly set up the security measures covered in the chapter
titled “Maintaining Security and Backing up Your Files.”

Active-X Component Registration

An Active-X component is a *.DLL file that resides in the Web server’s System folder.  Web-
Shop comes with a proprietary Active-X component called Send-MAX (short for “Send Mail
Active-X).  To successfully run your E-commerce Web site, Send-MAX must be registered on
your hosting company’s Windows NT-server.  Send-MAX automatically generates email
confirmations for you and your customers once a buy transaction is complete. To register Send-
MAX, contact your Web-hosting / ISP provider and ask them to register the Boomerang
Software Active-X component called Send-MAX.  For them to register Send-MAX, you will
need to send them the contents of the folder located on the WebShop program CD X:\Server
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Components\Send Mail  (where X designates your CD ROM drive).

The Send Mail  folder contains the following files:

••••• MailX .dll

••••• Readme .txt

••••• Reg.bat

••••• Unreg .bat

Once you have confirmed the contents of this folder, you will want to do the following:

1.  Copy the Send Mail  folder and place it on your hard disk.

2.  Send your Web-hosting/ISP provider the folder by email and ask them to run the batch file
Reg.bat  or upload your site (including the above files) and ask them to test Send MAX.

Be sure that your Web-host administrator reads the Readme text file before attempting to
register Send MAX.  Your Web Site/ISP provider can unregister Send MAX by running the
batch file Unreg .bat .  Send MAX has been fully tested on Windows NT-servers Running IIS.  If
there are any questions, from the Web Site/ISP provider, regarding the registration of the
Active-X component, Send MAX, have them call the Boomerang Software Technical Support
Department at (617) 484-4664 or email Boomerang Software, Inc. at either of the following
email addresses:

• techsupport@boomerangsoftware.com

• webhostingsupport@boomerangsoftware.com

Boomerang Software as a Web-Host Provider

Boomerang Software currently offers Web-hosting services.  There are a number of different
service plans to choose from:

••••• BASIC PLAN .  5 Mb.  of server space for a sub-domain name.  You may choose from one
of two URLs: www.uswebx.com or www.webhorizon.com.  Both of these URLs are
managed by Boomerang Software for its customers.

••••• BASIC PLUS .  50 Mb.  of server space.  The same policies from the Basic Plan option
apply except that you get ten times the server space with Basic Plus.

••••• PROFESSIONAL PLAN .  5 Mb.  of server space for a unique URL domain name.  You will
have to make sure that you locate a domain name, which is not already reserved.  The
Internet registration service, InterNIC (also called as Network Solutions), will bill you
separately for the first two years of domain name use.  Boomerang Software will assess a
onetime setup fee.

••••• PROFESSIONAL PLUS .  50 Mb.  of server space.  The same policies from the Professional
Plan option apply except that you get ten times the server space with Professional Plus.

To find out more about these service plans and prices:
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• Visit our Web site at www.boomerangsoftware.com, or

• Send an email to webhostingsupport@boomerangsoftware.com.

What is Your Integrated CNQ Project File?

One of the important parts of creating and maintaining a Web site is your ability to easily
manage the different HTML files and all other files that are generated and required to present
your site.

As you design and update your site, you will create not one single file, but many small files in
many different formats.  Some of these formats include *.HTML, *.GIF, *.JPEG, *.SCRIPTS,
*.CGI, and many others.  Losing, or having any one of them become corrupted, results in a
broken link, a Web site malfunction, or some other operation failure.  Keeping everything
together, and working, is very difficult if all your files reside independently on your hard disk.
WebShop fixes this problem by storing all of your files in a single integrated file format.  These
files have a special *.CNQ extension that is unique to WebShop.  That CNQ file contains the
page, graphic, and object resource files of your entire Web site.  When you want to work on
your Web site again, you simply open that one file! Everything is there.

Note: WebShop automatically creates a backup file (*.BAK) of your current CNQ file
whenever you execute a save.  You will want to be sure that you have both of these files.

Additional CNQ File Benefits
Not only does your CNQ file provide a single resource file for your entire Web site, but it also
saves your resource files in their original file formats.  This has important implications—
particularly for the graphic files you use.

Currently supported HTML specifications favor Internet images be in *.GIF or *.JPEG format.
These are pixel by pixel formats, similar to a bit map style format.  If you want to edit them or
change their size as part of your ongoing updates to your site, they may lose resolution and
versatility.  In addition, any special graphics that you create, using graphic drawing tools (which
might have special vector characteristics) will lose detail as soon as you place them on your site.
*.JPEG and *.GIF formats cannot support this kind of detail and to load these images on to your
site, these images must be converted.

WebShop’s CNQ file format avoids some of these problems.  When you save your Web site
project to a CNQ file, it saves your images in their original format.  The required conversion to
*.JPEG or *.GIF format does not happen until once your site is generated.  During site genera-
tion, WebShop creates all of the necessary files and folders automatically.  Any image resource
files, not currently in *.JPEG or *.GIF format, will be created and placed on the server in its
proper place.  That means you get the best of both worlds—a development file that saves your
work in its original format, and a production directory of files that organizes your work in a
format suitable for the Internet.

Note: To avoid problems, it is highly recommended that you follow the following strategy to
make updates to your site.  Once you create your site by generating and uploading it to your
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server—to make changes—do not  import the site from your server and make changes to
your HTML code directly.  Rather, you must open your Web site’s CNQ file from your hard
disk and make your changes to the CNQ file .  Then, after completing your changes,
regenerate and reload your site to your server.  In a worst-case, you may import your Web
site from the remote server if your CNQ file is lost or corrupted.

Saving Your Files in CNQ Format

By default, WebShop saves your Web site in CNQ format whenever you execute a save.  Once
you execute a save, all of the associated resources of your site are saved.  You do not save files
individually, in a piecemeal fashion.
All of your files are saved together at
the same time.

To initially save your Web site
project in CNQ format

1. Click Save from the File  menu.
The Save As dialog box appears.

2. Enter the name for your project.

3. Specify the directory location for
your file.

4. Click OK.

Generating and Upload-
ing Your Web Site

When you are ready to take your site to the Internet, you must use WebShop’s Site Generate or
Site Upload features.  The Site Generate feature takes your CNQ file and creates all of the
necessary files and folders automatically in a local directory.  Once you complete site genera-
tion, all of your files are ready for you to upload.

The Site Upload feature both generates and transfers your Web site files and folders from your
computer’s virtual memory to your server’s directory automatically.  Where Site Generate
creates files and folders on your hard disk, Site Upload only generates files to your remote ISP-
server.  You will want to use Site Upload during your initial development and testing.  To test a
new E-commerce site in development, you may want to upload your Web site many times,
successively, by overwriting the remote server files with each iteration.

Note: Overwriting is a file-to-file operation, not a folder-to-folder operation.  We recommend
that you selectively delete the files on your server prior to uploading new files—if your new
Web site has many instances of folder and file additions or deletions.  Warning ! Do not
overwrite your ShopDB.mdb file in your Database folder.
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Generating A New Site
You will only want to use the Generate Site feature when you want your Web site files stored
locally on your PC.  Remember! The files created by Generate Site are upload-ready.  Your
*.CNQ file is not upload-ready.

Once you save your CNQ file, you are ready to generate your site.  This operation creates and
places your Web site files where
you specify on your hard disk.  It
is recommended that you generate
it to another directory or folder
separate from the location of the
CNQ file.

To generate your site prior to
upload

1. Create a new folder title “My
WebSite ” on your hard drive.

2. Select File > Save  from the
File  menu options to execute
a save

3. Select File > Generate  Site
from the File  menu options.
The Browse For Folder
dialog box appears.

4. Select the folder “My
WebSite ” that you created.

Note: The Generate Site
feature will create a new
folder named “WebSite.” All of the sub folders and files necessary for the site will be created
and placed in this WebSite folder.  This folder will have the same total size as your original
CNQ file.

5. Click OK.  The program begins processing.  This may take some time.  When finished, the
message The site has been successfully generated  appears.

6. Click OK.

Uploading A New Site
Before you begin you will need to have your hosting service’s Internet domain name, your ISP-
assigned user name (or user login) and password.  In general, it is not necessary to know your
exact directory address (or upload path).  NT-servers with IIS installed identify folder address
locations by user name.  However, if you currently are hosting more than one site with the same
provider, you will need to specify your exact account location.
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When you first upload you will be
creating an FTP session profile,
that is, a predefined set of param-
eters that you can reuse.  Every
time you go to execute a Site
Upload (using that *.CNQ file),
WebShop remembers the most
recent upload profile for you and
will place the files on your remote
NT-server accordingly.

To upload a new site

1. Select File > Upload  Site  from the File  menu options.  The Upload Web Site dialog box
appears.

2. Click in the FTP Server Name or Address  field and type “ftp.<domainname.ext>”

3. Click in the User Login  and Password  fields and type “<user name>” and “<pass-
word>.”

4. Click in the Upload Path  field and type the directory address only if you have more than
one site associated with your user name/folder name.

5. To store your password for future use, click the Remember Password  check box.

Note: You might want to consider the security implications of saving your password.  If you
want to maintain tight control over your server files, do not save your password as part of
your FTP session profile.  For example, if someone other than you uses your computer, that
person is able to upload files to your server without your permission — if the password is
saved on the FTP session profile.  While it is a great convenience to save your ISP pass-
word, particularly if you are prone to forgetting passwords, you must weigh the possible
security implications.

6. Click Upload .

• If either your password or your User ID were incorrect, the message Password was
not allowed  appears.

• If you type the wrong FTP domain name, the message Server name or address could
not be resolved  appears.

• If your upload is successful, the message Upload was successful  appears.

Your Web site files are now stored in the Web server’s directory and are ready to be viewed
online.  The CNQ file remains on your hard disk.
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Uploading A Revised Site

When uploading a revised site, you must decide how you want to treat your site’s remote
database.  If you have been “live” for a while, your ShopDB.mdb file has dynamically created
data that does not exist in your local CNQ file.  This is valuable data.  Your remote
ShopDB.mdb file contains your customer records and order records.  If you overwrite this file,
you will permanently lose all of this information.  Therefore, you want to be careful not to
overwrite this data inadvertently.

Note: Your dynamically created data will be preserved if you un-check the Upload Data-
bases check box.

Also, be aware that when overwriting your remote server files, if you have removed a page or a
resource, you will not be overwriting those resources.  They will continue to exist on the remote
Web server even though they are not used.  To solve this problem, we recommend that you
selectively delete the files on your server prior to uploading new file.

Note: To delete existing files prior to uploading new ones requires a distinct FTP session
with appropriate server permissions.  If you encounter problems, call your provider for
support.

To upload a revised site

1. Select File > Upload  Site  from the File  menu options.  The Upload Web Site dialog box
appears.

Note: Since you have already uploaded this site before all of the fields on the Upload Web
Site dialog box should have
values entered.

2. If you did not select the
Remember Password  check
box, type your password.

3. Decide whether to overwrite
your server’s ShopDB.mdb
file.

• If you do  not want  to
overwrite this file, un-
check the Upload Data-
base  check box.

Warning! If your site is live (that is, no longer in development) do not overwrite your
ShopDB.mdb file.

4. Click Upload .

• If either your password or your User ID were incorrect, the message Password was
not allowed  appears.
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• If you code the wrong FTP domain name, the message Server name or address could
not be resolved  appears.

• If your upload is successful, the message Upload was successful  appears.

Note: You must call, or ask, the Web-hosting company to place the appropriate permissions
on your site folder (see the chapter titled “Maintaining Security and Backing up Your Files”).

Your Web site files are now stored in your server’s directory and are ready to be viewed online.

Uploading Selected Files

When uploading selected files, you will not be using the Upload Site feature, which uploads
your site all at once.  To gain more flexibility, you must use the File Transfer Protocol (FTP)
program included with some WebShop versions.  For selected version, WebShop comes with
the FTP program, WS_FTP Pro that you can use for a one-month trial period.  You must
selectively install this program.  When you install the FTP program it will be stored in its own
program folder, WS_FTP Pro .

Note: If your CD does not include WS_FTP Pro, the procedures covered in this section will
apply to most FTP programs.  If you are working with a different FTP program and want
more specific instruction, see the detailed procedures included with your FTP program
documentation.

To transfer your files selectively

1. Launch the WebShop program.

2. Open your project file.

3. Generate your site on your computer.

4. Set up an FTP session profile.

5. Establish connection with your remote ISP-server.

6. Specify the files that you want to transfer.

7. Execute transfer.

In general, it is not necessary to know the exact directory address on the NT-server where your
files are stored.  Most NT-servers identify folder addresses by user ID so a specific location is
not required.  However, if you are currently hosting more than one site with the same provider,
you might want to set up two FTP session profiles and record the exact address locations in
specifically defined session profiles.

To launch the FTP program

1. Click the Start  button on your Windows taskbar.

2. Select Programs > WS_FTP Pro > WS_FTP Pro .  The Session Properties dialog box
appears.

You are now ready to set up an FTP session profile that you can reuse every time you want to
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selectively upload or download files from your ISP-server.  To do this, you only need to enter
values for the fields under the General  tab.  You can accept the program defaults for all other
Session Properties  tab options.

To set up a reusable FTP session profile

1. With the General  tab selected, click New.  The General  tab fields are now empty.

2. Click in the Profile Name field and enter a profile name .  You might want to use the
name of your ISP and your ISP assigned user ID somewhere in your profile name.

3. Click in the Host Name/Address  field and type “ftp.<domainname.ext>.”

4. Accept the Host Type  field default.  The Automatic Detect value automatically detects the
server type.

5. Click in the User ID  and Password  fields and type “ <user name>”  and “ <password>.”

Note: Use the Anonymous check box whenever you want to enter an FTP site anonymously.
Some FTP sites have free downloading privileges.  In these cases, no user ID or password
is required.  Boomerang Software Web-hosting customers should leave Anonymous
unchecked.

 6. Click in the Account  field and
type the directory address only
if you have more than one site
associated with your user
name.

7. To store your password for
future use, click the Save Pwd
check box.

Note: You might want to consider
the security implications of
saving your password.  To
maintain tight control over your
server files, do not save your
password as part of your FTP
session profile.  If your password
is saved, others who use your
PC will be able to FTP files
without your knowledge.

8. To store a comment, click in the Comment  field and type whatever comment you want.

9. When done, click Apply  and then OK to record the profile and to initiate connection with
your ISP-server.

• If you type the wrong FTP domain name, the message Can’t get / FTP, <domain
name> host entry .  ! Connection failed  appears.

• If either your password or your User ID were incorrect, the message User <user ID>
cannot log in  ! Login failure  appears.
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• If your connection is successful, the message 226 Transfer complete  appears.  The
WS_FTP Pro dialog box appears.

The WS_FTP Pro program has successfully connected to your ISP-server.  You can now initiate
a file upload or download using the program dialog box.

The WS_FTP Pro dialog box has two sections.  The Local System section identifies the
location on your local drive where you want to upload or down load files either to or from.  The
Remote System  section identifies the location on your remote drive server where you want to
upload or down load files either to or from.  You can use the arrow buttons between the two
sections to upload or download files from these locations.  For more information about using
this dialog screen, see the help files that comes with the program.

To upload selected files to your ISP-server

1. Locate the files that you want to upload from your local system, by double-clicking on the
up arrow to move up in your local directory, or by using the scroll bar to move down in the
current directory location.  To open a folder, double-click on it.

2. Locate on your remote server the files that you want to transfer, by double-clicking on the
up arrow to move up in your local directory, or by using the scroll bar to move down in the
current directory location.  To open a folder, double-click on it.

3. Locate on your local system the files that you want to transfer.  Highlight the specific files
that you want to upload by clicking on them.  To select more than one file use either the
SHIFT key (for contiguous files) or the CTRL key (for selected files only) to make a
multiple selections.

4. To execute the transfer, click on the ARROW KEY that points from your local system to the
remote system.

Note: There are two arrow keys on the dialog box, one points from your local system to the
remote system for uploading.  The other points from the remote system to your local system
for downloading.  If you are transferring very large files, the transfer may take some time.
The program displays a progress indicator to inform you of its progress.

Note: If you are overwriting files, the programs asks if you want to copy over the existing file.
Respond Yes or No as necessary.

5. When the transfer is complete, the new files are listed in the Remote System’s directory
where you specified, or the over-written file lists the transfer data and time.  Select Close .

You will want to test out your revised Web site while leaving the FTP program open.  If there is
something wrong, you should fix it by making your changes to your development file, regener-
ating your site and upload your files again—without ever shutting down the FTP program.





Chapter 10.
Maintaining Security and Backing
Up Your Files

Introduction

To maintain security over your Web site, it is recommended that you implement a number of
security measures.

1.  Establish Site Security and Folder Security .  Instruct your Web site administrator, at your
remote ISP-server site, to place access restrictions around your entire Web site during develop-
ment and more specifically around your Administration Folder and Database folders once you
go live.  If you want you can create a development folder and use this folder during develop-
ment.  This is first-level security.

2.  Implement WebShop Administration Security .  Use the Store ID assigned to you when
you completed merchant registration along with the password you selected to limit access to
your database files.  This second-level security is automatic.  It is built into your E-commerce
functionality that comes with any of the E-commerce templates.

3.  Insure control over your FTP uploads .  When setting up your FTP profile, you should un-
check the Save Password  check box.  This provides an additional measure of security by
insuring that you must code your password every time you go to execute an FTP.

4.  Have your ISP/Web-hosting Company perform regular, periodic backups of your Web
site files.   If a problem were to arise, you would have backup files with a recent version of your
dynamic database records.  System administrators could reload these files and you would be
back in business.

5.  Maintain a current and updated CNQ file .  WebShop automatically creates a backup file
(*.BAK) but that is only a backup of your most recent CNQ file.  If you make changes to your
Web site directly to your Web-hosting service (for example, by adding new product images
using an FTP upload) then your Web site files and your CNQ files will be out of agreement.
Just so you don’t have to reinvent your Web site after going live, you should always have a
currently updated *CNQ file backup.
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Topics covered in this chapter include:

• Site Security and Folder Security

• WebShop Administration Security

• FTP Password Protection

• Web Server Site Backups

• Maintaining a Currently Updated CNQ File Backup

Site Security and Folder Security

Site Security .  During development, you should ask your Web server administrator to place
access restrictions around your entire Web site.  If you set up a development folder, then the
administrator would place restrictions on that folder by removing Internet User access (IUSR
access).  For at least a while, you will be uploading and testing your site as you work out all of
the features that you want to implement.  During this period, you will not want anyone to visit
your site. Removing Internet User access (IUSR access) will insure that no one has access to
your site except authorized users.

Folder Security .  Your Administration folder and Database folder, are critical to maintaining
control over your Web site once you go live.  By asking your ISP site administrator to place
access restrictions, at the folder level, you are restricting access to these folders to users who
have your ISP user ID and a password which includes you and anyone authorized by you.  That
means that anyone trying to access these folders, will be presented with a dialog box that
requires them to enter the ISP user ID and password.  If they fail, the system will not let them
have access.

WebShop Administration Security

WebShop administration security works with the Database Administration feature.  To access
your remote ISP database from any PC, you will want to go online and through your Web site’s
StoreFront, click on the Administration page link (see the chapter titled “Database Administra-
tion”). The page is stored in you Administration folder and will prompt first-level ISP security.
WebShop Administration security is your second-level security.  Once you successfully enter
your ISP user ID and password, you are asked to supply your Merchant Registration Store ID
and password. These values are stored on your ShopDB  database.  If the entered values do not
agree with the recorded values, the Administration page should not display.  Users should be
unable to perform administration procedures.  This provides additional security over your
remote database.
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FTP Password Protection

The Upload Site feature and most FTP programs record the FTP session profile used to initiate
an FTP file transfer.  These profiles are reusable and are a great timesaving.  You should be
aware that each profile contains a check box that allows you to store your ISP password, along
with the rest of your session information, to your hard disk.  If you think someone would use
your computer to upload files to your site without your permission, you might want to consider
the security implications of saving your password along with your user ID.

Note: If database security is important, it is recommended that you do not  save your
password as part of your FTP session profile.

Web Server Site Backups

One of the Web-hosting services that you should inquire about are regular periodic site backups.
Web-hosting service providers usually make regular backup of all server files in the event of a
system failure.  You will want to insure that your Web-hosting  provider makes regular backups
either weekly or monthly.

Maintaining a Currently Updated CNQ File Backup
Lastly, you will want to be sure to maintain a currently updated CNQ file back up.  As you
work with your Web site online, it is very easy for you to only maintain your Web server files
rather then your CNQ files.  Because there are dynamic elements in your database file, there
will be some differences between your locally stored CNQ file and your remotely stored files.
However, you should make every effort to minimize the data discrepancies between the two.
That means being sure to implement product updates to both files as well as any image file
updates.  Your CNQ resource files must agree with your remotely stored ISP resource files.
This would include navigation bar resources, image resources, and CGI script resources, Java
script resources, and multimedia resources.

Note: WebShop automatically creates a backup file (*.BAK) but that is only a backup of your
current CNQ file.  If you make changes to your Web site directly to your ISP (for example, by
adding new product images using an FTP upload) then your Web site files and your CNQ
files will be out of agreement.

To backup your CNQ file and publish your Web site changes to the Internet

1. Open your CNQ file from you hard disk’s backup folder where you previously saved the
CNQ file.

2. Make any updates or changes to your project using the WebShop program.

3. Save the project (as a *.CNQ file) in the backup folder on your hard disk again.
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4. Decide how you want to upload your changes.

• If you want to perform a Site Upload, see the procedure “To upload a revised site”
below.

• If you want to generate and save your Web site files and folders locally and then see
the  procedure “To transfer your files selectively” later in this chapter.

To upload a revised site

1.    Select File > Upload  Site  from the File  menu options. The Upload Web Site dialog box
appears.

2. If you did not select the Remember Password  check box, type your password.

3. Decide whether to overwrite your server’s ShopDB.mdb file.

• If you do  not want  to overwrite this file, un-check the Upload Database  check box.

• If you do want  to overwrite this file, place a check in the Upload Database  check box.

Warning!  If your site is live (that is, no longer in development) do not overwrite your
ShopDB.mdb file.

4.  Click Upload .

To transfer your files selectively

1. Select File > Generate  Site  from the File  menu options. The Browse For Folder dialog
box appears.

2. Select the folder where you want WebShop to place your files.

3. Click OK.  The program begins processing. When finished the message Site successfully
generated  appears.

4. Click OK.

5. Open your FTP program.

Note: For some versions of WebShop the FTP program WS_FTP_Pro is included.

6. Set up an FTP session profile.

7. Establish connection with your remote ISP-server.

8. Specify the files that you want to transfer using the FTP dialog box that comes with the
program.

Warning!  If your site is live (that is, no longer in development) do not overwrite your
ShopDB.mdb file.

9. Click Upload .



Appendix A.
Service Agreement with Credit
Processor

This agreement is entered into by and between you the user or merchant (“MERCHANT”), and the credit
processing company (“PROCESSOR “). The MERCHANT and PROCESSOR make this agreement in
consideration of the mutual covenants set forth herein. This agreement shall not be in effect until
MERCHANT has been issued a merchant processing number by an approved Bank and or Bankcard
Service Provider.  PROCESSOR’s field agent’s signature hereon constitutes only an offer made on behalf
of PROCESSOR.  This offer shall automatically expire after (60) days unless both MERCHANT and
PROCESSOR have signed this agreement.

ARTICLE 1 - SERVICE TO MERCHANTS

1.01 PROCESSOR agrees to provide MERCHANT with a secure interface for the acceptance of
Bankcards and/or Checks, through encryption software provided by V-One, Inc., over the Internet.

1.02 MERCHANT agrees to truthfully complete all forms required by PROCESSOR or the Bankcard
Service Provider it represents.  MERCHANT must purchase or lease the V-One encryption
software on the terms and conditions set forth in this agreement and/or on the equipment finance
lease.

1.03 MERCHANT agrees it will abide by the rules and regulations of the Card processing Bank and/or
it’s Bankcard Service Provider as set forth under their separate agreements.

1.04 MERCHANT agrees to abide by the rules and regulations of the Check Processing company as set
forth under their separate agreement.

1.05 PROCESSOR is not a partner or joint venturer with any company that provides any related
services or software products.  MERCHANT agrees to release PROCESSOR from any and all
liabilities arising from any disruption of any service.  These services are packaged only as a
convenience for the MERCHANT.  MERCHANT fully accepts and agrees to pay for any losses
caused by any failure of any service or software purchased under this agreement.

ARTICLE 2 - PRICE FOR SERVICE

2.01 MERCHANT shall pay a certain percentage of the gross monthly sales decrypted by the decryption
center. Other transaction fees or minimum monthly amounts may also apply.  All fees and costs are
specified in the final MERCHANT application and its related documentation which will be
furnished to the MERCHANT.  MERCHANT, Licensee, or user shall refer to those final docu-
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ments or Agreements for more accurate and detailed information.

2.02 PROCESSOR shall have the right to increase prices specified in this agreement provided that
PROCESSOR shall give the MERCHANT not less than 30 days advance written notice of any
such increases and such changes shall become effective after such 30 day period.

2.03 MERCHANT shall allow PROCESSOR to charge MERCHANTS designated DDA account for all
charges provided for in this agreement.  If the account should become delinquent, PROCESSOR
shall have the right to charge a late fee of up to $15 per month on the outstanding balance.  If
payment remains delinquent, PROCESSOR shall have the right to immediately terminate or
interrupt all services provided to MERCHANT by PROCESSOR.  A $15 fee will be charged to
reinstate a closed account or to change DDA accounts.

ARTICLE 3 - MISCELLANEOUS

3.01 AUTHORITY. Each party to this agreement hereby represents and warrants to the other that it has
full right, power and authority to enter into and perform this agreement in accordance with all the
terms , provisions, covenants and conditions hereof, and that the execution and delivery of this
agreement has been duly authorized by proper corporate action.

3.02 FORCE MAJEURE. PROCESSOR shall have no liability to MERCHANT for delay or failure to
perform any part of this agreement on account of any circumstances beyond PROCESSOR’S
reasonable control.

3.03 ATTORNEY’S FEES AND COSTS. MERCHANT shall be liable for and shall indemnify and
reimburse PROCESSOR for any and all attorney’s fees and other costs and expenses paid or
incurred by PROCESSOR in the enforcement hereof, or in collecting any amounts due from
MERCHANT to PROCESSOR hereunder or resulting from any breach of any of the terms or
conditions of this agreement.

3.04 LAW. This agreement shall be construed in accordance with and governed by the laws of Massa-
chusetts as applied to contracts that are executed and performed entirely in Massachusetts.



License Agreement and Warranty

IMPORTANT

Opening the software package and using WebShop Designer indicates acceptance of the terms of this License Agreement.

NOTICE OF COPYRIGHT

This software program package (“SOFTWARE”) is a proprietary product incorporating elements developed by Boomerang
Software, Inc. (“BOOMERANG”). This software is protected by copyright laws and international treaty. You must treat the
SOFTWARE like any other copyrighted material, except that you may either make one copy of the SOFTWARE for backup or
archival purposes, or you may place the SOFTWARE on a single mass storage device (media), such as a hard disk, provided
that you keep the original software for archival or backup purposes. Copyright laws prohibit making additional copies of the
SOFTWARE for any other reason. You may not copy written materials accompanying the SOFTWARE without the express
permission of BOOMERANG.

The WebShop Designer program, its screens, icons, sequence, and organization are copyrighted materials of BOOMERANG.
They may not be copied or duplicated in any medium without the written authorization of BOOMERANG.

SOFTWARE LICENSE AGREEMENT

The software on the WebShop Designer media is licensed to the user. Before using WebShop Designer, you should carefully
read the terms and conditions of this Agreement. This Agreement is a legal contract between you (the end user) and BOO-
MERANG. governing your use of the software. If you do not agree with these terms and conditions, please return the software
with all accompanying packaging materials to the vendor from who you purchased it for refund or credit. Return policies of
vendors may vary; you should check with your vendor as to their return policy on returning unused, unregistered software.
Return of software is subject to restocking charges and terms which will be applied and deducted from the initial cost paid by
the customer returning the software. This agreement shall also be binding on any subsequent authorized licensee. If you have
questions regarding this Agreement, contact BOOMERANG at
617-489-3000.

A.   BOOMERANG grants you the right to use one copy of the software on a single-user computer only. Installing the
SOFTWARE on a multi-user computer or network server is a violation of this Agreement.

B.   BOOMERANG further grants you the right to make a backup/archival copy of the SOFTWARE as set forth in the
Notification of Copyright.

C.  You may not sublicense, rent, or lease the SOFTWARE, but you may permanently transfer your license to use the
SOFTWARE and accompanying materials by delivering to another party the original media (that is, the CD-ROM), and
original user documentation materials comprising the SOFTWARE package. The new recipient of the SOFTWARE and
accompanying materials accepts this Agreement and is licensed under the terms of this Agreement upon initially using the
SOFTWARE.

LIMITED WARRANTY / LIMITATION OF REMEDIES

BOOMERANG warrants the original media (that is, the CD-ROM) on which the SOFTWARE is recorded to be free from
defects in workmanship under normal use for a period of thirty (30) days from the date of your purchase as evidenced by a
copy of the original receipt of payment. BOOMERANG’S entire liability and your exclusive remedy will be replacement of
the media that does not meet BOOMERANG’S limited warranty and is returned to BOOMERANG with a copy of the original
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receipt of payment. BOOMERANG will have no responsibility to replace media that has been damaged by accident, abuse, or
misapplication.

Under no circumstances including negligence, shall BOOMERANG be liable for any incidental, special, or consequential
damages that result from use or inability to use the SOFTWARE or related user documentation, including all user documenta-
tion delivered in digital format, even if BOOMERANG or any BOOMERANG authorized representatives have been advised
of the possibility of such damages, or that result from mistakes, omissions, interruptions, deletion of files, errors, defects, or
delays in operation or any failure of performance whether or not caused by events beyond BOOMERANG’S reasonable
control, including, but not limited to, acts of God, computer failure, theft, destruction, or unauthorized use of BOOMERANG
program or services provided by BOOMERANG in connection with the publication of the software covered by the License
Agreement.

Because any individual software title which (1) creates files combining multimedia functionality with hypertext markup
language (HTML) functionality and (2) is designed to create a commercial Web site (“WEB STORE”) to facilitate electronic
commerce over the public Internet is subject to many factors beyond the reasonable control of BOOMERANG, including but
limited to the known incompatibilities among widely-distributed programs for viewing HTML files over the public Internet
and private Internet Protocol (IP) networks, improper, insufficient, obsolete, or inoperable hardware or software configurations
on remote PCs accessing the public Internet or private IP networks, unforeseen congestion on the public Internet or private IP
networks, failure of public telecommunication transmission providers, failure of unknown third parties to deliver access to the
public Internet or the legal or illegal use of public and private communication systems by unknown third parties, you are
advised to verify all work created with this SOFTWARE.

You are further advised to verify all confirmed or unconfirmed attempted transactions from any fully identified or partially
identified end user (“CUSTOMER”) accessing the WEB STORE and strongly encouraged to make backup copies of all files,
reports, e-mail or any other administrative information generated as a result of work created with this program or attempts to
access Web sites generated through the use of this program.

BOOMERANG is in no way liable for the failure of any single electronic commerce transaction or any series of transaction
authorization failures experienced by one or more end-user merchants using this SOFTWARE program to sell any product or
service over any public or private communication system or by an end-user attempting to access any file or Web site through
any public or private communication system to purchase any product or service created by any licensed or unlicensed user of
this program.

Boomerang Software, Inc. cannot assume any responsibility or liability for any indirect, special, incidental, economic, cover
or consequential damages arising out of the use of or inability to use WebShop Designer or any component of the documenta-
tion included with the program, including any and all documentation delivered in digital format. In no case shall Boomerang
Software be liable for any amount exceeding the purchase amount paid by a licensed user for the software.

The information contained in the WebShop Designer documentation is subject to change.  Except as specifically provided,
Boomerang Software makes no warranty or representation, promise or guarantee, either express or implied, statutory or
otherwise, with respect to this software or user documentation, including their quality, performance, merchantability, or fitness
for a particular purpose. No Boomerang Software dealer, agent distributor, or reseller is authorized to make revisions to this
warranty.

Revisions to any component of the program or user documentation included with WebShop Designer may occur as deemed
necessary by Boomerang Software, Inc.  The information herein is believed to be, and is presented to be, accurate in all
respects.  However, Some states do not allow the exclusion or limitation of implied warranties or limitation of liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.

MS DOS, Windows, NT, Internet Explorer, Active Server Pages and True Type are trademarks of Microsoft Corporation, IBM
is a trademark of International Business Machines Corporation, Navigator is a trademark of Netscape Communications, and
PhotoSuite is a trademark of MGI Software.

All other product names or trademarks identified in the user documentation accompanying this SOFTWARE are trademarks or
registered trademarks of their respective companies. They are used in this book in an editorial fashion only. No such use, or
the use of any trade name, is intended to convey endorsement or other affiliation with Boomerang Software products.
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